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1

Getting Started

This section explains what SystemTest is and shows you how to use it. It
contains the following topics:

What Is SystemTest? (p. 1-2) Introduces SystemTest and the
kinds of tasks it can perform

Quick Tour of SystemTest (p. 1-3) Provides a quick tour of the
SystemTest desktop

Running Tests from the MATLAB
Command Line (p. 1-10)

Describes command-line test
execution

Building a Test: An Example
(p. 1-11)

Describes building and running tests
with SystemTest



1 Getting Started

What Is SystemTest?
SystemTest provides MATLAB® and Simulink® users with a framework that
integrates software, hardware, simulation, and other types of testing in one
environment. You use predefined elements to build test sections that simplify
the development and maintenance of standard test routines. You can save
and share tests throughout a development project to ensure standard and
repeatable test verification. SystemTest offers integrated data management
and analysis capabilities for creating and executing tests, and saving test
results to facilitate continuous testing across the development process.

SystemTest automates testing in MATLAB and Simulink products. With
SystemTest you get:

• Graphical test editing — Quickly edit your test within a graphical test
development environment.

• Repeatable test execution — All tests developed with SystemTest share the
same execution flow, which provides a consistent test framework among
tests.

• Parameterized testing — Create test vectors over which your test iterates.

• Reusability — After you design a test, you can save it for later use by you
or others.

• Maintainability — Because you design and execute tests from the
SystemTest desktop, you do not need to understand unfamiliar code or
concepts.

• Integration — SystemTest integrates with MATLAB, Simulink, and other
products based on MATLAB and Simulink.
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Quick Tour of SystemTest

In this section...

“Getting Familiar with the Desktop” on page 1-3

“General Desktop Features” on page 1-5

“Setting SystemTest Preferences” on page 1-7

“Viewing Test Results” on page 1-9

Getting Familiar with the Desktop
The SystemTest desktop is an integrated development environment that lets
you perform all of your testing activities from one centralized location. This
section provides a brief overview of the SystemTest environment. For more
information about how to use SystemTest to build tests and run them, see
“Building a Test: An Example” on page 1-11.

To get familiar with the SystemTest environment, open the SystemTest
desktop from MATLAB by selecting Start > MATLAB > SystemTest >
SystemTest Desktop or typing systemtest at the MATLAB command line.

1-3



1 Getting Started

The desktop has a number of different panes that aid you in building and
running your test.

• Test Browser — Shows the overall structure of a test. A test is made up of
Pre Test, Main Test, Save Results, and Post Test. Use the Test Browser to
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Quick Tour of SystemTest

add elements to your test. These elements determine what actions your
test performs.

• Test Vectors — Lets you define the parameters or test cases of your test.
The test vectors you define determine the number of iterations performed
by your test. Test vectors are automatically indexed during test execution.

• Test Variables — Lets you define variables used in the scope of your test.
Variables can serve both input and output functions in your test. You can
define variables that are declared in the Pre Test section of your test or in
the Main Test section of your test.

• Properties — Shows the properties of the test or the element you are
editing. The contents of this pane change when you select a section or
element in your test.

• Getting Started — Shows information to help you start using SystemTest.
If the Getting Started page is closed, select Help > SystemTest Getting
Started to open it.

• Desktop Help — Shows help about the element or aspect of the test that
is currently selected. For the full product Help, select Help > SystemTest
User’s Guide.

• Run Status — Shows a summary of the test’s execution status.

General Desktop Features
The SystemTest desktop has a variety of features to make navigation easier.

Context Menus
Many areas of the user interface have context menus. For example, if you
right-click in the Test Vectors, Test Variables, Resources, Run Status,
Getting Started, or Desktop Help panes, you can access these context
menus.

If you have the Elements pane open, you can add elements to your test
using the context menus. If you right-click any element there, you can insert
it directly into Pre Test, Main Test, or Post Test using the Elements pane
context menus. If that section of the test already contains elements, the
inserted element will be placed below the currently selected element in that
section. You can change the order of elements in the test by using the arrow
buttons in the Test Browser, or by dragging and dropping.
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1 Getting Started

Hot Keys
SystemTest offers various keyboard shortcuts, or hot keys, to access certain
commands via the keyboard. For example, pressing F5 is an alternative way
to run a test, and pressing Ctrl+N creates a new untitled test.

The full list of SystemTest hot keys is in Appendix A, “SystemTest Hot Keys”.

Undo/Redo Support
Undo and redo support is available through the Edit menu or on the
SystemTest toolbar. This feature allows you to undo actions you have done
throughout the desktop. The undo queue is global to the entire desktop. For
example if you add a test vector, and then perform an action in the Properties
pane, those two actions will be the last two items in the queue. The undo
order goes across all the panes in the desktop.

To use this feature, select the Edit > Undo action command, where action
is the last action you performed. Use the Undo command repeatedly to
undo multiple actions. The Edit > Redo action command will redo the last
undo you performed.

Most actions in the desktop are undoable. Note that some actions pertaining
to the elements that are part of the hardware toolboxes, Data Acquisition,
Instrument Control, and Image Acquisition, cannot be undone since they
involve connections to hardware.

The following actions will clear the list of actions in the Undo queue:

• Closing a test

• Opening a test

• Creating a new test

• Refreshing a Simulink model in the Simulink element

1-6
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Setting SystemTest Preferences
You can set SystemTest preferences by selecting File > Preferences on the
SystemTest desktop. This opens the MATLAB Preferences dialog box. Click
SystemTest in the left tree if SystemTest Preferences are not showing in
the right pane.

Most Recently Used Test List
This option determines how many tests will appear on the SystemTest File
menu’s most recent files list. The default is 4 tests. If you change it to 0, no
recent tests will appear on the list. The maximum number is 9.

1-7
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Test Run Options
Select Minimize SystemTest when starting a test if you want the
SystemTest desktop to minimize when a test starts running. This check box
is cleared by default.

Select Save test before running if you want SystemTest to save your test
before it runs. If this option is selected and you run a test that is not yet
saved, you will be prompted to name and save the test. This check box is
selected by default.

Note You can save a test any time, before or after running it, by selecting
File > Save.

Confirmation Dialog Boxes
You can also turn off confirmation dialog boxes used in SystemTest in
a different area of the Preferences dialog box by selecting General >
Confirmation Dialogs. Two SystemTest confirmation dialog boxes are
listed there:

• Warn about launching Test Results Viewer without any saved
results – Occurs if you attempt to open the Test Results Viewer when the
latest test that ran does not contain any mapped results under Saved
Results. To save results, click Saved Results in the Test Browser.

• Warn about using a Simulink model with an infinite simulation
stop time – Occurs if you attempt to run a test containing a Simulink
element that uses a model with an infinite simulation stop time.
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These two warnings are shown in the following figure.

Viewing Test Results
SystemTest includes a tool called the Test Results Viewer that you can use to
view the results you have chosen to save for your test. You can launch the tool
from the SystemTest Tools menu by selecting Tools > Test Results Viewer.
You can also configure the SystemTest environment to launch the Test Results
Viewer automatically after all test results you specified have been saved for
each iteration and test execution has completed. For more information, see
“Analyzing Your Test Results” on page 1-38.
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Running Tests from the MATLAB Command Line
You can run one or more SystemTest tests from the MATLAB command line,
using the strun function. This is useful for running multiple test files as a
batch or calling a test file as part of an M-file.

Note If you use this feature, it is a good idea to first run the test from the
SystemTest desktop to verify that elements are not in an error state, and that
the test will run successfully, before running it via the MATLAB command
line using the strun function.

The function takes the name of your test file as a string. The test file must be
on the MATLAB path, or you can specify the full path in the string.

For example, to run a test called mytest that is on the MATLAB path, use
this syntax:

strun('mytest')

To run a test called mytest that is not on the MATLAB path, but is in a local
directory called c:\work, use this syntax:

strun('c:\work\mytest.test')

To run multiple tests, use a cell array of strings, as follows:

strun({'mytest' 'mytest2'})

Note MATLAB will remain busy while tests are executing via the strun
command. Control is returned to the MATLAB command line once all tests
execute.

For more information about using strun, see the function page.
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Building a Test: An Example

In this section...

“Overview” on page 1-11

“Planning Your Test” on page 1-11

“Building Your Test” on page 1-12

“Running Your Test” on page 1-34

“Analyzing Your Test Results” on page 1-38

Overview
This section builds a simple example to illustrate the four primary stages of
testing: planning, building, and running the test, and viewing test results.

The example uses a simple MATLAB expression to emulate a scalar
measurement during each iteration of the test. The example uses an arbitrary
formula dependent on the test vector named signal to generate the Y data.
The example tests each measurement to determine if it falls within certain
specified limits. If a measurement exceeds these limits, that particular
iteration of the test fails. By default, the test fails if any iteration fails, but
you can configure other pass/fail criteria.

The following sections provide more information about each stage, building
the example test along the way. If you prefer, instead of working through the
following sections to build the example, you can load it into SystemTest by
running the Getting Started with SystemTest demo from the Demos page in
the MATLAB Help browser (under MATLAB > SystemTest > MATLAB) or
by entering systemtest Simple_Demo at the MATLAB command prompt.

Planning Your Test
In this first stage, you must identify what it is you want to test. SystemTest
lets you specify input data, such as measurements from a model or device, and
compare this input data to some predefined limits. Based on this comparison,
SystemTest can declare whether a test passes or fails. Keep the following in
mind as you plan tests:
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1 Getting Started

• Identify your test data and test vectors.

• Specify test limits and determine if these limits can be expressed as scalar
or matrix values. (The Limit Check element supports both scalar and
matrix data.)

• Determine what operations your test must perform. Must certain
operations happen before others?

• Determine pass/fail criteria for your test.

• Decide which test variables you want to save as test results.

After this planning, you can begin to construct your test, which is described in
“Building Your Test” on page 1-12.

Building Your Test
SystemTest provides a graphical integrated environment that you can use to
create and edit tests. Tests consist of elements, test vectors, and test variables.
You can use each of these entities to create a variety of test scenarios ranging
from a simple test that runs a series of elements once to a full parameter
sweep that iterates over the values of test vectors that you define.

The following sections show how to construct a test.

• “Starting SystemTest” on page 1-13

• “Structuring Your Test” on page 1-13

• “Creating a Test Vector” on page 1-14

• “Defining Test Variables” on page 1-18

• “Adding Elements” on page 1-20

• “Defining Pass/Fail Criteria” on page 1-30

• “Saving Test Results” on page 1-31

• “Test Report” on page 1-32

• “Saving Your Test” on page 1-34
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Starting SystemTest
Start by opening the SystemTest desktop using the MATLAB Start button.
To open SystemTest, select Start > MATLAB > SystemTest > SystemTest
Desktop.

Alternatively, you can execute the systemtest command from the MATLAB
command line.

SystemTest displays the desktop on your screen. See “Quick Tour of
SystemTest” on page 1-3 for an overview.

Structuring Your Test
SystemTest divides tests into three sections.

• Pre Test — This section is used to execute test elements in order to perform
any test set-up operations, such as initializing variables, loading data from
a file, and initializing system resources. Using Pre Test variables, you
can assign an initial value to a test variable that persists between Main
Test section iterations (unless another element in Main Test modifies the
value). Pre Test is not mandatory, but it can be used if your test requires
set-up operations to be performed.

• Main Test — Main Test defines the test elements that need to be
performed across the parameter space defined by your test vectors. In this
section Main Test variables are initialized before each Main Test iteration,
which lets you assign an initial value to a test variable each time the Main
Test runs. This is useful if your test variable has a derived value such as
being indexed by a test vector or is the result of a MATLAB expression.

The number of iterations performed in the Main Test is indicated in the
Test Browser in parentheses after Main Test. Iterations specifies the
number of times the Main Test section will be run. This is determined from
the test vectors you define. The SystemTest desktop also offers a Save
Results area for you to specify which test variables you want to save as
test results at the end of each Main Test iteration.

• Post Test — In this section you can perform any cleanup work necessary
at the completion of the Main Test section, such as clearing workspace
variables, closing a file, or freeing system resources.
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1 Getting Started

For more detailed information about the sections of the test, see “Working
with the Sections of a Test” on page 3-2.

The following figure illustrates the structure of a test in SystemTest.

Creating a Test Vector
Test vectors are composed of values derived from a MATLAB expression. You
can use any MATLAB expression that evaluates to a 1-by-N matrix or cell
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array to define your test vector. Using test vectors, you can iterate through
a range of values to see how a system performs. Test vectors constitute
parameterized testing in SystemTest. They are the test cases for your test.

For tests with multiple test vectors, the product of the lengths of the test
vectors defines the number of iterations the test performs. For example, if you
define the test vector [10 20 30], the test runs three times, using a value
of 10 for the first run, 20 for the second, and 30 for the final run. If you add
a second test vector with three other values, the total number of test runs
would be nine. SystemTest iterates through each vector in combination with
the other vector as though the test were a group of nested FOR loops—the
outermost loop being the first test vector in your table and the innermost loop
being the last test vector. The Main Test section in the Test Browser shows
the total number of test iterations defined by your test vectors.

For the example, use the vector [pi/15:pi/15:4*pi] which defines 60 values
for our test vector ranging from pi/15 to 4*pi in pi/15 increments. To specify
this test vector in SystemTest:

1 Click the New button in the Test Vectors pane.

The Insert Test Vector dialog box opens.
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2 Assign a name to the test vector by clicking the Name field. For this
example, name the test vector signal.

3 Assign a value to the test vector by clicking the Expression field. Enter
the test vector specified above for the pi values. Click OK.
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After you create the test vector, in the Test Browser pane, the Main Test
section label updates to include the number of iterations defined by the test
vector. It should say Main Test (60 Iterations).

Note Grouping test vectors determines how they will be iterated through
when the test runs. For information on grouping vectors, see “Creating
Grouped Test Vectors” on page 2-3.

Note You can also use probability distributions when you create a test vector.
For information see “Creating Randomized Test Vectors with Probability
Distributions” on page 2-5.
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Defining Test Variables
SystemTest uses test variables to define temporary storage variables that a
test acts on or generates. You assign test variables in the Pre Test or Main
Test sections of your test.

You can define Pre Test variables or Main Test variables. Using Pre Test
variables, you can assign an initial value to a test variable that persists
between Main Test section iterations (unless another element in Main Test
modifies the value). Pre Test is not mandatory, but it can be used if your test
requires set-up operations to be performed.

Main Test defines the test elements that need to be performed across the
parameter space defined by your test vectors. Main Test variables are
initialized before each Main Test iteration, which allows you to assign an
initial value to a test variable each time the Main Test runs. This is useful if
your test variable has a derived value such as being indexed by a test vector
or is the result of a MATLAB expression. You add elements in this section.

The example test requires three test variables:

• Y — Contains a value that will be calculated from the signal test vector
at each iteration.

• HiLimit — Contains the upper limit for Y that you do not want the signal
to exceed.

• LowLimit — Contains the lower limit for Y that you do not want the signal
to go below.

To create these test variables in SystemTest:

1 Click the Test Variables tab at the bottom of the SystemTest desktop
to access the Test Variables pane.

2 Click the New button to create a Pre Test or Main Test variable. The Insert
Test Variable dialog box opens. Leave the default value of Main Test in the
Assigned in field, to create a new Main Test variable.
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3 Assign a name to the test variable by clicking the Name field and entering
the test variable name. For this example, enter Y.

4 Set the test variable’s initial value by clicking the Initial Value field and
entering a value. For the example test variable Y, enter 0. Click OK.

Note If you do not provide an initial value, it will default to empty, that is
Var1 = []; in MATLAB code.
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5 Repeat steps 2 through 4 to create the remaining two test variables, using
the settings listed in the following table:

Variable Name Initial Value Assign in

HiLimit 1 Main Test

LowLimit -1 Main Test

Adding Elements
Elements are the actions that a test performs. SystemTest includes the
following set of elements, listed in alphabetical order.

• IF — Implements a logic control operator

• Limit Check — Specifies the comparison to be performed of the value(s)
under test and their expected value(s), or limit(s)

• MATLAB — Executes any MATLAB statements
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• Scalar Plot — Graphically shows the value of any test variable or vector, as
the test is executing, as a scalar plot

• Simulink — Runs a Simulink model. Note that you need to have a license
for Simulink to use this element.

• Stop — Implements a logic control operator

• Subsection — Creates a new section in a test that you can use to group
elements within

• Vector Plot — Graphically shows the value of any test variable or vector, as
the test is executing, as a vector plot

Note Some MathWorks products, such as Image Acquisition Toolbox, Data
Acquisition Toolbox, and Instrument Control Toolbox, provide their own
elements that integrate those products’ capabilities within SystemTest. If
you have licenses for those products, those elements will also appear in the
elements list.

For more information about using the basic elements, see Chapter 3, “Working
with the Basic Elements”.

You add elements to a section in your test; however, not all elements can be
added to all sections. For example, you can use a MATLAB element anywhere
within a test, but you can only use the Limit Check element in the Main
Test section.
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To illustrate using elements, let’s continue with this example. This test uses
three elements in the Main Test section:

Element Description

MATLAB Use a MATLAB expression to assign data to Y that is
dependent on the test vector signal.

Limit Check Compare the value generated in the MATLAB element to
the specified limit and see if the Y test variable exceeds
the upper or lower limit you defined in your HiLimit and
LowLimit test variables.

Scalar Plot Plot the current test variable values and see whether the
test variable exceeds the upper and lower limits.
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To add these elements in SystemTest:

1 Select the section of the test in which you want to add the element. For this
example, click Main Test in the Test Browser.

2 Specify the element you want to add to the test section. For this example,
click the New Test Element button and select MATLAB. SystemTest
adds a MATLAB element to the Main Test section of your test and opens
the MATLAB element property page in the Properties pane of the
SystemTest desktop.
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3 In the Properties pane, type the following M-code in the MATLAB Script
edit box. This MATLAB code calculates a value for Y that is dependent
on the test vector signal.

Y = sin(signal)+ rand -.5;
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During each iteration, SystemTest evaluates the MATLAB expression and
assigns a value to Y.

4 Add the Limit Check element to the Main Test section of the test. With
the MATLAB element selected, click the New Test Element button, and
click Limit Check. SystemTest adds a Limit Check element to the Main
Test section of the test and opens the Limit Check properties page in the
Properties pane. For this example, the Limit Check element must follow
the MATLAB element in the test.

Note You can reposition an element in a test by selecting the element
and then clicking the up and down arrows in the Test Browser toolbar.
You can also drag and drop elements within Main Test. You cannot move
elements between test sections.
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In the General Check tab, click the New button to add a limit check.
Notice that the Limit Check element icon in the Test Browser shows
a red x, which indicates that information is missing. The corresponding
red outlining in the Properties pane highlights any fields that require
configuration. A test cannot run unless everything is properly configured.
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5 Specify the limit comparison operations in the Limit Check element.

a In the Test Variable column, click the drop-down list and select a test
variable you created in step 4. For this example, select Y.

b In the Operator column, click the drop-down list and select
the comparison you want to perform. For this example, pick the
less-than-or-equal-to operator, <=.

c In the Limit column, click the drop-down list and select the test variable
you want to compare to. For this example, select HiLimit, which is the
test variable you created earlier.

The following figure shows the configuration of this limit:

6 To add another limit comparison operation, click the New button again in
the General Check Properties pane. SystemTest adds a new row below
the last limit you specified. In this new row, set Test Variable to Y, set
Operator to >=, and set Limit to LowLimit.
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The following figure shows the configuration of this second limit:

For each iteration of the Main Test, the MATLAB element’s expression is
evaluated and a new value assigned to Y. When the Limit Check element
runs, it determines whether the value of Y falls between the HiLimit and
LowLimit values. If Y is outside this range, the test iteration fails. The
default pass/fail criteria for the overall test passes the test only if both
expressions in the limit check evaluate to true.

7 To view the test variables as the test runs, plot the data. To add a Plot
element to the test, click the New Test Element button, and select Scalar
Plot. SystemTest adds a Scalar Plot element to the Main Test section, and
opens the properties page for the element in the Properties pane.

1-28



Building a Test: An Example

With each Main Test iteration of the test, the Scalar Plot element updates a
figure window with data you selected.

8 Click the New button twice in the Properties pane and set the three
rows to match the following table:

Y Axis Line Color Line Style Line Marker

Y Blue Solid Point

HiLimit Red Dashed No Marker

LowLimit Black Dashed No Marker
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Defining Pass/Fail Criteria
You can define whether your test passes or fails by making SystemTest
monitor the outcome of any or all Limit Check elements during any or all
Main Test iterations. Your test’s threshold of success can range from the
passing of any Limit Check in any single test iteration to the passing of all
Limit Check elements in all test iterations. If your test contains no Limit
Check elements, there is no notion of pass/fail and no pass/fail information is
displayed. (Testing of this type is useful for experimenting with a system or to
explore its behavior rather than validate its performance.)

You can set any of the following conditions to define when your test passes:

• All Limit Check elements pass in all test iterations.

• All Limit Check elements pass in any test iteration.

• Any Limit Check element passes in all test iterations.

• Any Limit Check element passes in any test iteration.
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You can configure this behavior within the test’s Properties pane. Click the
test name in the Test Browser (named Untitled by default) to open the
test’s properties and look for the section labeled This Test Passes If.

Using the signal test example that you constructed in this section, set the test
to pass if all Limit Check elements pass in all test iterations.

Saving Test Results
SystemTest saves the results from the iterations of your test in a MAT-file. You
must explicitly specify which test variables you want to save as test results.

SystemTest gives you the ability to save results at the end of each iteration.
Before you run your test, select the Save Results section in your test and
specify which test variables you want to save as test results. Click the New
Mapping button and then select from the drop-down list the name of the test
variable you want to map to a result. You can optionally specify a name for
the results that you want to save. By default, the name of the saved result
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will be the same as the test vector or test variable. The following figure shows
the mapping of test variables to test results:

After you specify which test variables you want to save as test results, you
can specify the name of the MAT-file that SystemTest uses. Using this
MAT-file you can reload the test results into the base workspace. By default,
SystemTest names the file Untitled_results.mat and puts the file in the
current working directory (visible in the SystemTest toolbar). To change the
name or location of the MAT-file, click on the test name in the Test Browser,
then in the Properties pane, use the Test Results Save Options field.

By default, each time you run the test you overwrite this file unless you select
the Create new numbered test results option on the test Properties pane.

Note Test variables that are not saved as a test result will be lost at the end
of the test execution.

Test Report
When you run your test, SystemTest displays the status of the test in the Run
Status pane. This display contains basic information about your test:

• Time elapsed since your test started running.
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• Which section your test is in.

• How many test iterations have passed or failed as defined by any limit
checks.

• Whether your test completed successfully.

• Any errors that cause your test to stop.

You can make SystemTest generate and save more detail about the running
test by enabling the Test Report, which is a test execution log file in html
format. This report is especially useful when you use limit checks in your
test and you want to see specific test iterations that passed or failed. For
example, instead of just finding that a test iteration failed, the report helps
you determine how far a test variable varied from the upper or lower limit
defined in a Limit Check element. This report is also useful for documenting
and sharing your test results.

To enable the Test Report, click the Generate a report of the test
execution option button on the Test Properties pane.

The Test Report contains the following information about the test run,
organized by iteration in the report:

• The test description, if you entered one in the Properties pane of the test.

• A test summary, including start and stop times, number of iterations
completed, number of iterations that passed and failed, and final status
of the test.

• Pass/fail results of Limit Check elements, by iteration.

• Values for any saved results you captured by setting up mappings in Saved
Results, by iteration.

• Test vector values, by iteration.

• A snapshot of your model if you use a Simulink element in the test.

• A snapshot of your plot if you use a Vector Plot or Scalar Plot element in
your test, by iteration.

• A summary of generated files, with links to them. These can include a
Simulink model coverage report and the test results launched in the Test
Results Viewer.
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Note Because SystemTest generates the Test Report while the test is
running, this option results in the test taking longer to execute.

The report file is located in a subdirectory of the folder where you have
chosen to store your test results MAT-file. The subdirectory will be named
<testname>_report, where testname is the name of the active test. The Test
Report will be stored in this directory, along with all dependent files, such as
plot or Simulink model snapshots. The overwrite options you set for your test
results MAT-file also apply to the file name and directory of your report file.
See “Saving Test Results” on page 1-31 to learn how to change these options.

See “Viewing the Test Report” on page 1-38 to see what information the
report generates.

Saving Your Test
SystemTest lets you save tests so that you can reuse them later. For example,
to save the signal test:

1 Select File > Save As to open the Save file as dialog box.

2 Select a directory location and enter mySavedTest in the File name field.

3 Click Save.

SystemTest saves the test as mySavedTest.test and renames your test as it
appears in the Test Browser. This does not rename the test results MAT-file
or the Test Report file. Their names are controlled separately from the name
of the test, as explained in “Saving Test Results” on page 1-31.

Running Your Test
After you build a test, you are ready to run it. At run time, SystemTest
assigns values to test vectors and test variables in the order they appear in
the Test Vectors and Test Variables panes. Each test section runs elements
in the order that they appear in the Test Browser.
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To execute your test, do one of the following:

• Click the Run button.

• Select Run > Run.

• Press the F5 key.

Note While a test is running, you can stop its execution by pressing Ctrl+C
or clicking the Stop button on the toolbar.

Tracking Output
While the test runs, the Run Status pane shows summary test output,
including start and stop times, number of iterations completed, number of
iterations that passed and failed, and final status of the test. It will also
display any error messages if the test has an error.
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If your test includes a Plot element, SystemTest creates the plot and updates
the plot during each iteration. Since Limit Check elements evaluate whether
an iteration passed or failed, they directly affect the data that appears in the
Test Report and the Run Status pane.

In the example test, the plot includes the high and low limits defined in the
Limit Check element, to show which test iterations exceed the limits.
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When the test is done running, the Run Status pane provides links to
generated output. The Generated Files section contains a summary of
generated files, with links to them. These can include the Test Report; the test
results, opened in the Test Results Viewer; and a Simulink model coverage
report, if your test uses the model coverage feature.

Analyzing Your Test Results
After SystemTest runs your test, you can explore the results that SystemTest
generated. This section shows how to:

• View and interpret the Test Report.

• Inspect your test results with the Test Results Viewer.

Viewing the Test Report
When you enable the Test Report, SystemTest saves information about
each test iteration in an HTML file. To enable the Test Report, check the
Generate a report of the test execution option on the Properties pane
before running your test. The report contains summary information about
the test run, snapshots of any plots you used, snapshots of any models you
used, pass/fail results of Limit Check elements, and other information. See
Test Report for a full description of what the report contains.
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After a test runs, you can see the contents of this file by clicking the Test
Report button on the SystemTest toolbar or using the Test Report link in
the Run Status pane. The generated output resembles the following:
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The Main Test section of the report shows each iteration. You see the value of
the test vector signal and determine the values the Limit Check element used
in evaluating whether the test passed. For the first several iterations, the
value of Y did not exceed either the high or low limits so the iterations passed.
You can also see this in the scalar plot drawn while the test ran. For other
iterations that failed, you can scroll through the report to find the values of Y.

Viewing Test Results in the Test Results Viewer
To help you analyze your test results, SystemTest includes a tool, called the
Test Results Viewer, that provides a variety of plotting tools and the ability to
compare data. With this tool, you can see how your test results compare to the
test vectors used as inputs to your test.

You can start the Test Results Viewer by selecting it from the Tools menu.
You can also configure a test to launch the Test Results Viewer automatically
when the test completes. To do this, select the test in the Test Browser
and select the Visualize and plot saved results by launching the Test
Results Viewer option on the test’s Properties pane.

The test vectors in your test and the test results you selected to be saved
appear within the viewer so you can immediately start to explore your data.
For any selected test vector or test result, you can see a summary of statistics
for its values in the Data pane. For example, after running the test, the
viewer opens showing the saved test results and signal test vector. Clicking
the Y test result shows information such as the highest and lowest values that
Y evaluated to during the test. It also shows the mean, median, and standard
deviation for all values.
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The viewer has a rich selection of plotting capabilities that you can use to
visualize your test results. Plotting capabilities include line, scatter, time
series, surf, waterfall, and image plots. Using the signal example, you can
reproduce the line plot that your scalar plot element generated during the test.
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1 Click the Line Plot button.

2 In the Define Plot pane, click the X Axis list and select signal. Note that
you should choose signal or Auto values for the X-axis if you want to show
test vectors; line plots that use the X-axis for test vectors let you see how
each test iteration value corresponds to a test result.

3 Click the Y Axis list and select Y.

4 Click the Plot button.

You now have a line plot that resembles the scalar plot.

You can make this plot show the HiLimit and LowLimit test results too.
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1 In the Define Plot pane, click the Multiple Y Data option. The Y Axis
field expands to show all saved test results from your test.

2 Select the check boxes next to HiLimit and LowLimit.

3 Click the Refresh Plot button.

Constraining Data for Further Analysis
Using the Test Results Viewer constraint capability, you can filter out data.
For example to see only the test iterations that passed the test, you can create
two constraints that screen out data that exceeds the upper and lower limits.

Note By default, the Test Results Viewer provides a list of test vector
constraints for you to choose from.

To create and configure the constraints:

1 Click the New Constraint button in the Constraints pane to open the
Add a New Constraint dialog box.

�������	
��
�
���

��

2 Click the Using a result or test vector option button.

3 Select Y from the list.
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4 Click OK. A new constraint appears in the Constraints pane.

5 Create another constraint by repeating steps 1 to 4.

6 Click the check box next to the first constraint to activate it.

7 Make sure the operator is set to >=.

8 Click the constraint’s text field and change the constraint to -1.

9 Click the check box next to the second constraint to activate it.

10 Click the operator and set it to <=.

11 Click the constraint’s text field and change the constraint’s value to 1.

The green indicator bar beneath the constraints shows how many iterations
remain following the filter you applied. This is also reflected in the line plot,
which the viewer redraws after you apply the new constraints. As you can
see, only a subset of your test result remains.
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You can just as easily show only the iterations of your test that failed by
reconfiguring the constraints you created to filter out data that is < -1 or
> 1. Alternatively, you can create a new constraint that uses a MATLAB
expression. For example:

1 Delete the constraints you just created.

a Select the constraint row.

b Click the Delete button.

2 Click the New Constraint button in the Constraints pane. The Add a
New Constraint dialog box appears.

3 Click the Using a MATLAB expression option button.

4 Enter the expression Y<-1||Y>1.

5 Click OK.

6 Select the check box next to the constraint.

The Test Results Viewer redraws the line plot to now show only those test
iterations that failed.
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For more information about the Test Results Viewer, see Chapter 9, “Using
the Test Results Viewer”.

Saving Your Test Results
You can save the plotting and analysis work done in the Test Results Viewer.
Data, constraints, and plots created in the Test Results Viewer can be saved
and then reloaded in order to continue working on or viewing the data, or to
share it with others.

To save your test results and the state of the Test Results Viewer, use the File
> Save Test Results or File > Save Test Results As commands from the
Test Results Viewer desktop.

For more information on what is saved and on how to reload your saved files,
see “Saving and Reloading Test Results” on page 9-41.
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Creating Test Vectors
Test vectors define the parameter space or set of test cases you want to run.
Test vectors are composed of values that can be derived from a MATLAB
expression. You can use any MATLAB expression that evaluates to a 1-by-N
matrix or cell array to define your test vector. You must have at least one test
vector defined to run a test.

The total number of Main Test iterations is determined by permuting all test
vector values. For example, if one test vector is a 1-by-3 array and another is
1-by-2, it would result in a total of six iterations covering all the test vector
value combinations.

To add a test vector:

1 Click the New button in the Test Vectors pane.

2 In the Insert Test Vector dialog box, assign a name to the vector.

3 Enter the value by typing in values or a MATLAB expression in the
Expression field.

The Vector and Number of iterations fields fill in automatically based
on what you entered. For example, if you entered 1 : 1 : 10 in the
Expression field, the Vector would fill in as [1 2 3 4 5 6 7 8 9 10], and
the Number of iterations would be 10.

Note Grouping test vectors determines how they will be iterated through
when the test runs. For information on grouping vectors, see “Creating
Grouped Test Vectors” on page 2-3.

For an example of creating test vectors in a test, see “Creating a Test Vector”
on page 1-14.
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Creating Grouped Test Vectors
When you create a test vector, it is an ungrouped vector by default. You can
also create grouped vectors, in order to affect the way iterations are run. By
grouping test vectors, they will be indexed simultaneously with the other
grouped vectors. Each set of grouped values are then permuted with all the
ungrouped test vectors. This gives more control over the flow of tests and is
useful for Monte Carlo or Design of Experiments (DOE) based testing as well
as defining signal groups, similar to those defined in the Simulink Signal
Builder block.

For example, if you are testing a throttle body controller, you may want to
sweep across a range of input level or a gain values, while simultaneously
selecting different throttle body types, each defined by their mass and
damping characteristics.

An example of the vectors in this scenario could look like this:

gain = [1 10 100]
mass = [a b c d]
damping = [w x y z]

If the gain vector is ungrouped, and the mass and damping vectors are
grouped, it will result in mass and damping being indexed simultaneously for
each value of gain. The test runs would look like this:

Run 1: (1, a, w)
Run 2: (1, b, x)
Run 3: (1, c, y)
Run 4: (1, d, z)
Run 5: (10, a, w)
Run 6: (10, b, x)
Run 7: (10, c, y)
Run 8: (10, d, z)
Run 9: (100, a, w)
Run 10: (100, b, x)
Run 11: (100, c, y)
Run 12: (100, d, z)
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Note Grouped test vectors must be the same length.

You create a grouped test vector as you do any other vector, by clicking the
New button in the Test Vectors pane. To make a vector grouped, change
the selection in the Grouping field of the Insert Test Vector dialog box to
Grouped. (Ungrouped is the default.)
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Creating Randomized Test Vectors with Probability
Distributions

In this section...

“Using Probability Distributions in Test Vectors” on page 2-5

“Creating a Test Vector with Probability Distributions” on page 2-5

“The Probability Distributions” on page 2-11

“Example: Creating Test Vectors with Probability Distributions” on page
2-19

Using Probability Distributions in Test Vectors
SystemTest provides an easy way to generate randomized test vector values
for your test. You can use probability distribution functions to set up test
vectors, which is useful for performing Monte Carlo analyses.

If you have Statistics Toolbox, SystemTest integrates with it to provide
use of some of its probability distribution functions, such as exponential,
gamma, lognormal, T (Student’s t), and Weibull. If you do not have Statistics
Toolbox, you can use the MATLAB probability distribution functions normal
(Gaussian) and uniform.

Creating a Test Vector with Probability Distributions
You can use a probability distribution when you create or edit a test vector. To
use a probability distribution:

1 In the Test Vectors pane, click the New button.

2 In the Insert Test Vector dialog box, enter a name for the new vector in
the Name field.
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3 Click the Probability Distributions button.
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4 In the Probability Distributions dialog box, select a distribution function
from the Distribution list.

If you have Statistics Toolbox, all of the functions shown in the figure
appear in the list. If you do not have this toolbox, you can use normal
(Gaussian) and uniform.

For information on the distribution functions, see “The Probability
Distributions” on page 2-11.

5 Once you select a distribution, the relevant options appear in the
Probability Distributions dialog box. Fill in the parameters for your
distribution.
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For example, normal (Gaussian) allows you to set Mean and Standard
deviation.

6 After setting the relevant probability parameters, type in the Number of
values you want to use. That is the number of values you would like to
generate for the test vector.

The Number of values must be a positive integer. It must also be the same
value for all of your probability distributions because the vector is grouped.

7 Click OK in the Probability Distributions dialog box.

The Insert Test Vector dialog box fills in the values you just created.
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In the case of probability distributions, the numbers in the Expression
field are the random values created by the distribution function. The
values are used and displayed instead of the expression, so that you can
repeat tests using the same values.

Randomized test vectors with probability distributions are grouped by
default, as indicated by Grouped being selected.
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Grouping test vectors is useful for reducing the number of iterations to
execute. It means that SystemTest will sequentially combine values for
all grouped test vectors, instead of permuting their values. In the case of
randomized test vectors, grouping avoids introducing additional variation
into your test. See Creating Grouped Test Vectors for more information on
grouped test vectors.

Test vectors using probability distribution functions will always evaluate to
a 1-by-N vector.

8 Click OK in the Insert Test Vector dialog box.

The new vector then appears in the Test Vectors pane.

You can move your cursor over the Expression field of the new vector to
see a ToolTip containing the values, as shown above.
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The Probability Distributions
If you have Statistics Toolbox, SystemTest integrates with it to provide use of
some of its probability distribution functions, such as exponential, gamma,
lognormal, T (Student’s t), and Weibull. If you do not have Statistics Toolbox,
you have access to the MATLAB probability distribution functions normal
(Gaussian) and uniform.

SystemTest supports the distribution functions shown in the following
sections. Click the Probability Distributions button in the Insert Test
Vector dialog box to access the functions.

The Probability Distributions dialog box shows fields specific to the
distribution you pick in the list, as shown in the sections below. In each case,
enter values for the function-specific parameters, and then enter the Number
of values you want to generate for the test vector.

Normal (Gaussian)
The normal distribution is a two-parameter family of curves. The first
parameter is the mean. The second parameter is standard deviation. Normal
is often used for data that is symmetrical about the mean.
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Normal uses the function randn and takes parameters for Mean and
Standard deviation. SystemTest uses the following calculation for normal:

mean + Std_Dev * randn(1, #values)

For more information, see randn in the MATLAB documentation.

Uniform
The uniform distribution (also called rectangular) has a constant probability
density function between its two parameters, the minimum and the maximum.

The uniform distribution is appropriate for representing the distribution of
round-off errors in values tabulated to a particular number of decimal places.
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Uniform uses the function rand and takes parameters for Minimum value
and Maximum value. SystemTest uses the following calculation for uniform:

min + (max-min) * rand(1, #values)

For more information, see rand in the MATLAB documentation.

Exponential
The exponential distribution is a special case of the gamma distribution. The
exponential distribution is special because of its utility in modeling events
that occur randomly over time.

Exponential is often used to model the time between independent events
that happen at a constant average rate. For example, you could use it for the
time it takes a radioactive particle decays, or the time between messages
sent over a network.
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Exponential uses the function exprnd and takes one parameter for Mean.

For more information, see Exponential Distribution in the Statistics Toolbox
documentation.
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Gamma
The gamma distribution models sums of exponentially distributed random
variables.

Gamma uses the function gamrnd and takes parameters for A and B.

For more information, see Gamma Distribution in the Statistics Toolbox
documentation.
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Lognormal
The normal and lognormal distributions are closely related. The lognormal
distribution is applicable when the quantity of interest must be positive, since
log(X) exists only when X is positive.

Lognormal can be used to model something that can be thought of as the
multiplicative product of many small independent factors. A common
example is the long-term return rate on a stock investment, because it can
be considered as the product of daily return rates.

Lognormal uses the logrnd function and takes parameters for Mean and
Standard deviation.

For more information, see Lognormal Distribution in the Statistics Toolbox
documentation.

2-16



Creating Randomized Test Vectors with Probability Distributions

T
The T (Student’s t) distribution is a family of curves that depend on a single
parameter v (the degrees of freedom). As v goes to infinity, the T distribution
approaches the standard normal distribution.

T is often used to estimate properties when the sample size is small.

T uses the trnd function and takes one parameter for Degrees of freedom.

For more information, see Student’s t Distribution in the Statistics Toolbox
documentation.
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Weibull
The Weibull distribution is an appropriate analytical tool for modeling the
breaking strength of materials. Current usage also includes reliability
and lifetime modeling. The Weibull distribution is more flexible than the
exponential distribution for these purposes.

Weibull uses the function wblrnd and takes parameters for A and B.

For more information, see Weibull Distribution in the Statistics Toolbox
documentation.
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Example: Creating Test Vectors with Probability
Distributions
Many models must take into account the effect of evaluating uncertainty in
model parameters. In this example the tester needs to account for uncertainty
in electric motor characteristics that come off the production line so the
tester defines the model’s parameters as distributions of values, rather than
as single fixed values. The tester then performs a Monte Carlo simulation,
running the model repeatedly with random combinations of parameter values
to account for variability in manufacturing.

In this case, the tester defines the uncertain motor parameters as test vectors.
The test varies parameters for armature resistance, armature inductance,
and shaft inertia.

To create the first vector, for armature resistance:

1 In the Test Vectors pane, click the New button.

2 In the Insert Test Vector dialog box, enter ArmatureResistance in the
Name field.
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3 Click the Probability Distributions button.
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4 In the Probability Distributions dialog box, use the default distribution,
normal (Gaussian).

You do not need to have Statistics Toolbox installed to use normal
(Gaussian) since it is included with MATLAB.

5 In the Mean field, enter 1.71.

6 In the Standard deviation field, enter .056.
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7 In the Number of values field, enter 1000.

For this vector, the test is varying armature resistance up to a standard
deviation of .056, around a mean of 1.71, and using 1000 values.

8 Click OK in the Probability Distributions dialog box.

2-22



Creating Randomized Test Vectors with Probability Distributions

The values appear in the Insert Test Vector dialog box.
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9 Click OK in the Insert Test Vector dialog box.

The new vector appears in the Test Vectors pane.

To create the second vector, for armature inductance:

1 In the Test Vectors pane, click the New button.

2 In the Insert Test Vector dialog box, enter ArmatureInductance in the
Name field.

3 Click the Probability Distributions button.

4 In the Probability Distributions dialog box, use the default distribution,
normal (Gaussian).

5 In the Mean field, enter .3.

6 In the Standard deviation field, enter .01.
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7 In the Number of values field, enter 1000.

For this vector, the test is varying armature inductance up to a standard
deviation of .01, around a mean of .3, and using 1000 values.

8 Click OK in the Probability Distributions dialog box.

The values appear in the Insert Test Vector dialog box.

9 Click OK in the Insert Test Vector dialog box.

The new vector appears in the Test Vectors pane.
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To create the third vector, for shaft inertia:

1 In the Test Vectors pane, click the New button.

2 In the Insert Test Vector dialog box, enter ShaftInertia in the Name field.

3 Click the Probability Distributions button.

4 In the Probability Distributions dialog box, use the default distribution,
normal (Gaussian).

5 In the Mean field, enter 44.5.

6 In the Standard deviation field, enter .443.
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7 In the Number of values field, enter 1000.

For this vector, the test is varying shaft inertia up to a standard deviation
of .443, around a mean of 44.5, and using 1000 values.

8 Click OK in the Probability Distributions dialog box.

The values appear in the Insert Test Vector dialog box.
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9 Click OK in the Insert Test Vector dialog box.

The new vector appears in the Test Vectors pane.
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Working with the Basic
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Working with the Sections of a Test
(p. 3-2)

Describes the three sections of the
test and which elements you can add
to each one

Basic Elements (p. 3-5) Describes the basic elements, which
sections of the test you can add them
to, how they work, and their options
in the Properties pane
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Working with the Sections of a Test

In this section...

“Overview” on page 3-2

“Pre Test” on page 3-2

“Main Test” on page 3-3

“Post Test” on page 3-3

Overview
Each section of the test serves a different purpose and has different properties
that can be set in the Properties pane. Click a part of the test or an element
in the Test Browser to see the properties for that section or element.

The descriptions of the elements in this chapter include a list of which sections
of the test you can use each element in. The following sections describe the
sections of a test. They are followed by a description of how to use the basic
elements.

Pre Test
The Pre Test runs once prior to any number of iterations through Main Test.
Pre Test can be used to perform general test setup such as:

• Opening a model.

• Initializing variables.

• Accessing system resources, such as opening a file.

• Initializing external test equipment.

In Pre Test, only test variables defined as a Pre Test variable may be modified
or assigned to. Pre Test variables are initialized during Pre Test and persist
throughout the Main Test and Post Test.

In Pre Test you can add the following element types: Simulink, MATLAB,
Subsection, Stop, IF, Video Input, the three Instrument Control Toolbox
elements, and the four Data Acquisition Toolbox elements.
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With Pre Test you can initialize Pre Test variables and run elements that you
only want to run once before any Main Test iterations. For example, you can:

• Add a Simulink element to run a model and assign baseline data to a Pre
Test variable.

• Add a MATLAB element to load a MAT-file or perform some other test
setup.

• Create conditions with the IF element and follow up with a Subsection
element to define what to do when those conditions are met.

Main Test
The Main Test is run one or more times based on the number of iterations.
It is used to:

• Execute elements multiple times in order to perform batch testing or sweep
through a parameter space.

• Perform batch testing or parameter sweeps that require multiple
independent iterations using different test conditions for each iteration.

The number of iterations is defined by the number and length of test vectors
you specify. SystemTest executes Main Test once for each permutation of
values in the test vectors specified.

In Main Test you can add all of the element types.

Post Test
The Post test runs once after all Main Test iterations have executed or when
a run-time error occurs in Pre Test or Main Test. Post Test can be used to
perform test cleanup, such as:

• Closing a model.

• Cleaning up your workspace.

• Releasing system resources, such as closing a file.

• Returning external test equipment to a safe state.
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In Post Test you can add the following element types: MATLAB, Subsection,
IF, Video Input, the three Instrument Control Toolbox elements, and the four
Data Acquisition Toolbox elements.
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Basic Elements

In this section...

“Introduction” on page 3-5

“MATLAB Element” on page 3-6

“Limit Check Element — General Check” on page 3-7

“Limit Check Element — Tolerance Check” on page 3-11

“IF Element” on page 3-14

“Vector Plot Element” on page 3-15

“Scalar Plot Element” on page 3-17

“Stop Element” on page 3-19

“Subsection Element” on page 3-20

Introduction
The sections listed above describe how to work with the basic elements.

The Simulink element is covered in detail in Chapter 4, “Using the Simulink
Element”. The hardware elements are covered in detail in “Introduction” on
page 7-2 in Using the Image Acquisition Toolbox Element, “Introduction” on
page 6-2 in Using the Data Acquisition Toolbox Elements, and “Introduction”
on page 5-2 in Using the Instrument Control Toolbox Elements.

To see the MATLAB, Limit Check, and Scalar Plot elements used in an
example, see “Adding Elements” on page 1-20.

Tip You can rename any element or subsection by double-clicking its name
in the Test Browser.
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Invalid Characters in Element Names
The following characters are invalid to include within element names:

• ’

• <

• >

You cannot use these three characters in element names. If you create a new
test element with one or more of these characters in the element name, then
SystemTest throws an error dialog and the element name is reset to the
default value, which is the name of the element type.

If you try to load an existing test with an invalid element name (containing
one or more of the three characters listed above), SystemTest displays an
error dialog indicating that the element name is invalid. The test will load
successfully, but the element with an invalid name is reset to use the default
name for the element. If this occurs, simply rename the element to a name
that does not contain any of the invalid characters.

MATLAB Element
The MATLAB element lets you run MATLAB scripts from within a test.
In addition to specifying any valid MATLAB script to execute, you can
incorporate any test variable into your code, as well as access any variables
residing in the MATLAB workspace.

Allowed Test Sections
The MATLAB element can be used in the following test sections:

• Pre Test

• Main Test

• Post Test
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Properties Pane
In the MATLAB Script edit field, enter any valid MATLAB script.

Limit Check Element — General Check
The General Check tab of the Limit Check element determines test
conditions are met by using scalar, vector, or matrix comparisons. It can be
used to:

• Compare measured data to expected data.

• Stop an iteration or an entire test if a test constraint is violated.

• Assign a test variable the logical value derived from the comparison(s)
for use by other elements.

You can do the following types of comparisons with the General Check tab
of the Limit Check element:

• Scalar versus scalar

• Scalar versus vector

• Vector versus vector
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• Matrix versus matrix

Note Use the Tolerance Check tab of the Limit Check element to test
absolute and relative tolerance.

Allowed Test Sections
The Limit Check element can be used in the following test section:

• Main Test

3-8



Basic Elements

How to Use

1 Click the New button on the General Check tab to add a general limit
check.
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• Select an existing test variable or create a new one in the Test Variable
column.

• Select an operator in the Operator column.

• Select an existing test variable or test vector or create a new one in the
Limit column.

2 Set your test’s passing conditions.

• The element can pass if all comparisons complete successfully (a logical
AND).

• The element can pass if one or more of the comparisons complete
successfully (a logical OR).

3 Set your fallback procedure if the element fails. You can:

• Allow the current iteration to continue executing.

• Stop the current iteration and proceed to the next iteration.

• Stop the test and proceed to Post Test.

4 Identify the SystemTest test variable you want to assign the logical value
derived from the comparison(s) in the Assign data to field.

Note Aside from setting limit checks on individual elements, you can set
these properties for the entire test, reachable by clicking the test name in the
Test Browser, to determine pass/fail criteria for the test as a whole.

Properties Pane — General Check
You can set the following properties for the Limit Check element:

• Test Variable — Value to compare to limit using operator.

• Operator — Boolean operator used to compare test variable to limit.

• Limit — Value to compare to test variable using operator.

• For this element to pass — Choose between a logical AND (all
comparisons must pass) or a logical OR (at least one comparison needs to
pass) for the element to pass.
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• If this element fails — Choose between continuing the test, stopping the
current iteration, or stopping the entire test.

• Assign data to — Test variable assigned the logical value of this
evaluation. The logical value will be 1 if the element passes or 0 if the
element fails.

Limit Check Element — Tolerance Check
The Tolerance Check tab of the Limit Check element verifies test conditions
are met by using absolute and relative tolerance comparisons. It can be
used to:

• Compare measured data to expected data.

• Stop an iteration or an entire test if a test constraint is violated.

• Assign a test variable the logical value derived from the comparison(s)
for use by other elements.

• Define pass/fail criteria for an iteration.

You can do the following types of comparisons with the Tolerance Check tab
of the Limit Check element:

• Absolute tolerance

• Relative tolerance

For a definition of these tolerance types, see the Properties Pane section.

Note Use the General Check tab of the Limit Check element to test scalar,
vector, and matrix comparisons.

Allowed Test Sections
The Limit Check element can be used in the following test section:

• Main Test
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How to Use

1 Click the New button on the Tolerance Check tab to add a tolerance
limit check.
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• Select an existing test variable or create a new one in the Test Variable
column.

• Select an existing test variable or test vector or create a new one in the
Expected Value column.

• Select Absolute or Relative in the Tolerance Type column.

• Select an existing test variable or test vector or create a new one in the
Tolerance Limit column.

2 Set your test’s passing conditions.

• The element can pass if all comparisons complete successfully (a logical
AND).

• The element can pass if one or more of the comparisons complete
successfully (a logical OR).

3 Set your fallback procedure if the element fails. You can:

• Allow the current iteration to continue executing.

• Stop the current iteration and proceed to the next iteration.

• Stop the test and proceed to Post Test.

4 Identify the SystemTest test variable you want to assign the logical value
derived from the comparison(s) in the Assign data to field.

Note Aside from setting limit checks on individual elements, you can set
these properties for the entire test, reachable by clicking the test name in the
Test Browser, to determine pass/fail criteria for the test as a whole.

Properties Pane — Tolerance Check
You can set the following properties for the Limit Check element.

• Test Variable — Variable to compare with expected value using a
tolerance limit.

• Expected Value — Expected value to compare variable to using a
tolerance limit.

3-13



3 Working with the Basic Elements

• Tolerance Type — Tolerance type used to compare test variable to the
expected value. Select Absolute or Relative. Absolute tolerance is
calculated using this formula: abs(test variable - expected value)
<= tolerance limit. Relative tolerance is calculated using this formula:
abs(test variable - expected value) <= tolerance limit.*
abs(expected value).

• Tolerance Limit — Value used as the tolerance constraint to compare
variable and expected value.

• For this element to pass — Choose between a logical AND (all
comparisons must pass) or a logical OR (at least one comparison needs to
pass) for the element to pass.

• If this element fails — Choose between continuing the test, stopping the
current iteration, or stopping the entire test.

• Assign data to: — Test variable assigned the logical value of this
evaluation. The logical value will be 1 if the element passes or 0 if the
element fails.

IF Element
The IF element provides logical control of a test by evaluating a condition.

The IF element allows sub-elements to run only when the IF element’s
condition evaluates to true. After adding an IF element, you should add one
or more elements to perform a specific task.
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Allowed Test Sections
The IF element can be used in the following test sections:

• Pre Test

• Main Test

• Post Test

Properties Pane
You can set the following property for the IF element.

• Condition — Enter a valid MATLAB expression that will evaluate to
true or false.

Vector Plot Element
The Vector Plot element is used to plot array or vector data over multiple
iterations.

Use this element during the Main Test to generate plots of any test
variables containing array or vector data. You can change the number of
iterations displayed to as many as 16 (in a 4-by-4 matrix) using the Subplot
Dimensions fields. The default is one iteration.
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Allowed Test Sections
The Vector Plot element can be used in the following test section:

• Main Test
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Plot Type
Choose one of the following plot types:

• plot — Standard plot of X and Y.

• semilogx — Semilogarithmic plot with logarithmic X-axis.

• semilogy — Semilogarithmic plot with logarithmic Y-axis.

• loglog — Log-log scale plot.

• stem — Lines extending from a baseline along the X-axis.

Properties Pane
You can set the following properties for the Vector Plot element.

• X Axis — Choose a test variable to use for an X-axis value.

• Y Axis — Choose a test variable to use for a Y-axis value.

• Line Color — Select a color to use for the line between each data point.

• Line Style — Set the type of line to be drawn between each data point.

• Line Marker — Choose a symbol to represent each data point.

Subplot Dimensions

• Rows — The number of rows you want displayed in the Subplots window.

• Columns — The number of columns you want displayed in the Subplots
window.

• Clear axes between iterations — Applies only when you have one row
and one column to display. Selecting this option (default) rewrites the plot
with new data during each iteration. Clearing this option adds new data to
the plot during each iteration.

Scalar Plot Element
The Scalar Plot element is used to plot scalar data for each iteration.

Use this element during the Main Test to generate a plot of one or more
scalar test variables.
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Allowed Test Sections
The Scalar Plot element can be used in the following test section:

• Main Test

Plot Type
Choose one of the following plot types:

• plot — Standard plot of X and Y.

• semilogx — Semilogarithmic plot with logarithmic X-axis.

• semilogy — Semilogarithmic plot with logarithmic Y-axis.

• loglog — Log-log scale plot.
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• stem — Lines extending from a baseline along the X-axis.

Properties Pane
You can set the following properties for the Scalar Plot element.

• Maximum Number of Points to Display at Once — Determine how
many points to show simultaneously. By default this is infinite such that
all points will be plotted. Use a MATLAB numeric that evaluates to a
positive, nonzero integer to set this field’s value.

• X Axis — Choose a test variable to use for an X-axis value.

• Y Axis — Choose a test variable to use for a Y-axis value.

• Line Color — Select a color to use for the line between each data point.

• Line Style — Set the type of line to be drawn between each data point.

• Line Marker — Choose a symbol to represent each data point.

Stop Element
The Stop element stops an iteration or an entire test unconditionally.

You can use the Stop element with conditional logic elements, such as the IF
element, to control the test’s execution.

Allowed Test Sections
The Stop element can be used in the following test sections:

• Pre Test

• Main Test
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Properties Pane
You can set the following properties for the Stop element.

• When this element runs — Select a stop action for use in Main Test. The
Current iteration stops option stops the current Main Test iteration. The
All testing stops option stops all Main Test iterations and runs Post Test.

Note that when a Stop element is used in Pre Test, All testing stops is the
only option, since Pre Test does not have iterations.

• Display Message — Enter a message to display in the Test Report.

Subsection Element
Use subsection elements to organize one or more elements to maintain
readability of your test or to better manage complex test structures. Use
a subsection to:

• Group elements under a single root element.

• Organize tests.

• Manage complex test structures.
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Allowed Test Sections
The Subsection element can be used in the following test sections:

• Pre Test

• Main Test

• Post Test

Properties Pane
You can set the following properties for the Subsection element.

• Description — Type in your description of the subsection.
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4

Using the Simulink
Element

The Simulink element allows you to override the inputs to a Simulink model
with SystemTest test vectors and test variables. You can further map the
model’s outputs to SystemTest test variables for later processing by other test
elements. This means that you can use SystemTest to define, generate or load
input data, feed it into Simulink, run the model while iterating over the input
data, and map the outputs back into SystemTest.

Note To use the Simulink element, you must have a license for Simulink.

Before You Begin (p. 4-3) Prerequisite steps to take if you
intend to use the examples provided
with the procedures in this chapter

Mapping Test Vectors and Test
Variables to a Simulink Model
(p. 4-5)

Describes how to map test vectors
and test variables to Simulink
inputs and Simulink outputs to test
variables

Using Simulink Model Coverage
(p. 4-21)

Describes how to use the Simulink
Verification and Validation model
coverage feature



4 Using the Simulink Element

Note In Simulink elements, you cannot have more than one model with the
same name. Each model referenced within a test must have a unique name. If
you ran a test containing two models with the same name, SystemTest would
only use one of the models.
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Before You Begin
This chapter explains the Simulink setup by having you recreate the Simulink
element that is part of the Inverted Pendulum demo. Before continuing, you
should load this demo from MATLAB and delete the Simulink element from
the demo.

The following steps describe how to do this:

1 Start MATLAB.

2 Open the Inverted Pendulum demo.

a Select Start > Demos to open the Help browser.

b Expand the MATLAB list from the left frame of the browser.

c Select SystemTest. The SystemTest demos open in the right browser
frame.

d Click “Simulink - Mapping and Overriding Simulink Data Using an
Inverted Pendulum Model.” An overview of the demo opens.

e Click the link “Open the demo in the SystemTest Desktop” at the bottom
of the page.

Alternatively, you can enter the following command at the MATLAB
command line:

systemtest InvertedPendulum

The SystemTest desktop opens with the Inverted Pendulum demo loaded.

3 Click the Simulink element in the Test Browser.
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4 Click the Delete element button in the Test Browser button bar or press
the Delete key.

4-4



Mapping Test Vectors and Test Variables to a Simulink Model

Mapping Test Vectors and Test Variables to a Simulink
Model

In this section...

“Introduction” on page 4-5

“Adding a Simulink Element” on page 4-5

“Specifying the Simulink Model” on page 4-6

“Overriding Simulink Model Inputs” on page 4-7

“Mapping Simulink Model Outputs to Test Variables” on page 4-13

Introduction
To help you learn how to use the Simulink element, this section walks you
through the configuration of the Simulink element for the Inverted Pendulum
test. The Inverted Pendulum demo includes both a model of the pendulum
and a model of a controller that keeps the inverted pendulum balanced.
Moving the bottom of the pendulum disturbs the equilibrium, causing the
pendulum to move and the controller to rebalance it. The Inverted Pendulum
test varies the mass of the pendulum, the mass of the cart the pendulum is
on, and the distance to the pendulum’s center of mass, testing the robustness
of the controller as it attempts to return the pendulum to equilibrium. Using
the Simulink element in a test lets you vary the model inputs and assess
the model outputs.

Note The following sections assume you have loaded the Inverted Pendulum
demo and deleted the Simulink element, as explained in “Before You Begin”
on page 4-3.

Adding a Simulink Element
To add a Simulink element to a test, click the New Test Element button in
the Test Browser and select the Simulink element. If you have a license for
Simulink, the element list contains the Simulink element, as shown in the
following figure.

4-5



4 Using the Simulink Element

SystemTest adds the Simulink element to the test and opens the Simulink
element Properties pane.

Specifying the Simulink Model
When you first add the element, the icon in the Test Browser has a red x,
meaning that the element requires some information. The Simulink model
field in the Simulink element Properties pane is outlined in red, indicating
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that it is a required field. You must specify the model that the Simulink
element will interact with. If the model is on the MATLAB path, you can type
its name in the Simulink model field. If you are not sure of the name, or
the model is not on the path, you can browse to its location using the browse
button.

For the Inverted Pendulum example, type systemtestpendulum in
the Simulink model field and press Enter. SystemTest opens the
systemtestpendulum model in Simulink and opens the Pendulum
Visualization window.

Overriding Simulink Model Inputs
Using test vectors and test variables, you can override the following Simulink
model inputs:

• Block parameters — Described in “Overriding Simulink Block Parameters”
on page 4-7

• Model and base workspace variables — Described in “Overriding to
Workspace Variables” on page 4-9

• Inport signals — Described in “Overriding Simulink Model Inport Signals”
on page 4-11

Overriding Simulink Block Parameters
You can override Simulink block parameters with SystemTest test vectors
or test variables. When you run the test, Simulink runs the model using
data provided by SystemTest. Overriding does not change your Simulink
model file; it only overrides in the test. The procedure for creating block
parameter overrides requires that you select your block in the Simulink
model, but everything else you need to do happens within the Simulink
element Properties pane.

To override a Simulink block parameter:

1 In the Mappings tab of the Properties pane for the Simulink element in
SystemTest, find the Define Model Overrides area and click the New
Mapping button, and select Select Block to Add. This opens the model
in Simulink, if it is not already open.
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2 In the Simulink model window, click the block containing the parameter
you want to override. For this example, click the Pendulum block in the
systemtestpendulum model window.

3 In SystemTest, return to the Simulink element Properties pane and, in
the Define Model Overrides area, you’ll see that the Block Pendulum
Parameter was added. If you click the New Mapping button again, you’ll
see that SystemTest also adds an entry to this menu for the block.

In the override table, the Simulink Data field shows that this entry is
linked to the Pendulum block but the question mark (?) indicates that no
parameter for the block has been mapped.

4 Select the parameter from the block that you want to map. Click the
Simulink Data field for the block and select a parameter from the list. For
the Inverted Pendulum demo example, select Pendulum:Mass of cart
(kg).

5 Specify the SystemTest test vector or test variable you want to map to this
block parameter. Click the SystemTest Data field for the block parameter.
This shows you all defined SystemTest test vectors and test variables
available for mapping. For this example, select cart.
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Overriding to Workspace Variables
You can use a SystemTest test vector or test variable to override either a
MATLAB base workspace variable or a Simulink model workspace variable.
This lets you define test values and conditions in SystemTest and have a
Simulink model act on them.

This section describes how you can use the values in the pend and distance
test vectors to override the model workspace variables masspend and
penddistance in the Inverted Pendulum demo.

To override workspace variables:

1 In the Define Model Overrides area of the Simulink element Properties
pane, click the New Mapping button and select Workspace Variable.
SystemTest adds a row for a new mapping of this type.
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2 Select the workspace variable you want to override. Click the Simulink
Data field of this row to see all available base workspace variables and
Simulink model workspace variables. For the Inverted Pendulum example,
select masspend.

3 Specify which SystemTest test vector or test variable you want to map to
the Simulink workspace variable. Click the SystemTest Data field of this
row to see all available test vectors and test variables. For this example,
select pend.

4 Repeat steps 1 to 3 to override the Simulink model workspace variable
penddistance with the SystemTest test vector distance.
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Overriding Simulink Model Inport Signals
As with block parameters and workspace variables, you can use SystemTest
to override a model’s inport signals. This lets you externally manipulate the
input signal of a Simulink model.

You use the same procedure to map an inport signal that you use for mapping
block parameters and workspace variables. Click the New Mapping button
and select Inport Signal. SystemTest creates a new row for the mapping.
Then you can choose the inport signal to override from the Simulink Data
field and select the SystemTest test vector or test variable to be mapped from
the SystemTest Data field.

The Inverted Pendulum demo example does not override any inport signals.

Optimizing Test Vectors to Work with Inport Signals

Simulink allows you to import input signal and initial state data from the
MATLAB workspace and export output signal and state data to the MATLAB
workspace during simulation. In SystemTest, you can specify the contents of
a test vector so that it is used as a Simulink inport. To do that, use the vector
as the mapping in your Simulink element, by selecting it in the SystemTest
Data row as described above.

The Simulink documentation contains guidance on importing data to Simulink
inport signals. You can create the same type of data in your SystemTest
test vectors that you then map to inport signals. For more information on
appropriate data types, see Importing and Exporting Simulation Data in
the Simulink documentation.
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Example for Overriding Inport Signals Using Data Arrays

One of the data formats described in Importing and Exporting Simulation
Data in the Simulink documentation is the use of data arrays for specifying
input data to an Inport block. This example uses the systemtestinputdemo.mdl
model to illustrate how SystemTest can be used to override the three Inport
blocks in the model with test signals.

The first step involves constructing a test vector that specifies the different
signal test cases. This can be done by creating a MATLAB function that
simply returns a test vector containing the different test cases you would
like to use for each test iteration. A sample MATLAB function, called
GETTESTVECTOR, that does this is provided below.

Once this function is saved as GETTESTVECTOR, you can create a
SystemTest test vector whose expression is set to GETTESTVECTOR. This
will create a 1-by-3 test vector cell array within SystemTest, where each entry
in the cell array represents the time and signal data for the three Inport
blocks.
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For detailed information on the Simulink data array format, or other formats
supported by Simulink Inport blocks, see Importing and Exporting Simulation
Data in the Simulink documentation.

Mapping Simulink Model Outputs to Test Variables
Using test variables you can assign the output from the following types of
Simulink model data:

• Logged signals — Described in “Mapping Simulink Logged Signals to Test
Variables” on page 4-13

• Outport signals — Described in “Mapping Simulink Outport Signals to
Test Variables” on page 4-15

• To Workspace blocks — Described in “Mapping Simulink To Workspace
Blocks to Test Variables” on page 4-17

After you map model outputs to test variables, you can incorporate the model
data into SystemTest. This section shows you how to map this data for the
Inverted Pendulum example.

Note The output from Simulink models can only be mapped to SystemTest
test variables. You cannot map this output to SystemTest test vectors.

Mapping Simulink Logged Signals to Test Variables
Logged signals are a way to obtain outputs from a model without adding more
outports. Using logged signals, you can identify a particular signal and map
the output to a SystemTest test variable.

To map logged signals to a SystemTest test variable:

1 In the Map Simulink Data to Test Variables area of the Simulink
element Properties pane, click the New Mapping button. From the list,
select Logged Signal. SystemTest adds a row for a new mapping of this
type.
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2 Specify the signal you want to capture. Click the Simulink Data field
to see all the signals in the model. For the Inverted Pendulum example,
select pendout.

Note If you added logged signals to your model and they do not appear
in this list, click the refresh button, on the Properties pane next to the
model name, to update the list.

3 Specify the SystemTest test variable to which you want to map the output.
Click the SystemTest Data field and select a test variable. For the
Inverted Pendulum example, select st_loggedsignal.
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SystemTest creates the mapping to the test variable.

Mapping Simulink Outport Signals to Test Variables
SystemTest lets you map all outport signals to a test variable for further
processing in SystemTest.

To map Simulink outport signals to a test variable:

1 In the Map Simulink Data to Test Variables area of the Simulink
element Properties pane, click the New Mapping button. From the list,
select Outport Signal. SystemTest adds a row for a new mapping of this
type.
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2 Specify the outport signal you want to capture. Click the Simulink Data
field and select a signal. For this example, select Out1.

3 Specify the SystemTest test variable to which you want to map the outport
signals. Click the SystemTest Data field and select a test variable from
the list. For this example, select st_outportsignal.
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SystemTest creates the mapping to the test variable.

Mapping Simulink To Workspace Blocks to Test Variables
When Simulink runs a model with To Workspace blocks, these blocks
save model information in the MATLAB workspace as variables. Using
SystemTest, this data can be mapped to SystemTest test variables.

This section shows how you create To Workspace block mappings in
SystemTest using the Inverted Pendulum demo as an example.

To map the To Workspace block:

1 In the Map Simulink Data to Test Variables area of the Simulink
element Properties pane, click the New Mapping button. From the list,
select To Workspace Block. SystemTest adds a row for a new mapping
of this type.
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2 Specify the To Workspace block in the model that you want to capture.
Click the Simulink Data field and select the block from the list. For this
example, select To Workspace.

3 Specify the SystemTest test variable to which you want to map the To
Workspace block. Click the SystemTest Data field and select a test
variable from the list. For this example, select New Test Variable to
create a test variable.
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SystemTest opens the Edit Variable dialog box. Assign a name to the test
variable and optionally an initial value, and then click OK. Name the test
variable ToWSResult.
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SystemTest creates the mapping to the new test variable and adds the new
test variable to the list in the Test Variables pane.
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Using Simulink Model Coverage
The model coverage feature provided by Simulink Verification and Validation
allows you to generate coverage analysis metrics for a Simulink model,
which can be incorporated directly into your SystemTest test. Model
coverage metrics allow you to validate your model by identifying unexecuted
subsystems, unselected switch positions, or untaken conditional transition
paths. You can generate a cumulative coverage report, specify individual
coverage options, or inherit a model’s coverage settings.

Note To use the model coverage feature, you need a license for Simulink
Verification and Validation.

The following basic steps describe the typical work flow to use this feature:

1 Use an existing Simulink element or add one by clicking the New Test
Element button and selecting Simulink.

2 On the Properties pane, browse for your Simulink model using the browse
button next to the Simulink model field.

To see an example, you can run the Signal Builder demo by typing
systemtest SignalBuilderDemo in MATLAB.

3 Configure the Simulink element as described in this chapter, using the
Mappings tab of the Properties pane to define model overrides and map
Simulink data to test variables.

4 On the Model Coverage tab, which appears if you have a license for
Simulink Verification and Validation, select the Enable model coverage
check box. The following figure shows the Signal Builder demo.
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5 If you want to use the model coverage settings you already have on the
Simulink model, select the Inherit coverage metric settings from the
model option. Then go to step 9.

6 If you want to override the existing settings, select the Override model
coverage metric settings option.
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7 Click the Browse button to specify the Coverage Instrumentation Path.
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8 In the Coverage Metrics area, select the types of coverage your test
requires. The selected coverage types will be generated and shown in the
coverage report.

9 Use the Map Coverage Data to SystemTest Variables field to map
coverage metrics to test variables. Click New Mapping and select Full
Coverage Instrumentation Path if you want coverage data below the
root you specified under Coverage Instrumentation Path, or select
Select Path to Map if you want to pick an alternate coverage path, which
must be within the coverage instrumentation path. If you select the latter,
your Simulink model will open and you can select a block to specify an
alternate root for your coverage path.
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10 Select the Metric you want to map to a test variable, and specify the test
variable to use under the SystemTest Data column.

11 Run your test.

12 View the coverage report by clicking the link in the Run Status pane.
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For more information on the model coverage feature, see “Using Model
Coverage” in the Simulink Verification and Validation documentation.
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Introduction

In this section...

“Instrument Control Toolbox Elements” on page 5-2

“Accessing Resources” on page 5-2

Instrument Control Toolbox Elements
This chapter describes how to use the Instrument Control Toolbox elements
with SystemTest.

The Instrument Control Toolbox elements provide a way to bring data from
instruments into a SystemTest test, or to transmit data from your instrument.
You can use these elements along with the other elements in SystemTest to
create tests for Simulink models and other applications.

Note To use the Instrument Control Toolbox elements, you need a license
for Instrument Control Toolbox. These three elements will not appear in
SystemTest without this license.

Instrument Control Toolbox provides three of elements that you can use in
SystemTest:

• To Instrument — For sending commands or data to your instrument

• From Instrument — For reading data from your instrument

• Query Instrument — For querying your instrument status or properties

You can configure these elements to communicate with your instruments by
using SystemTest resources supported by Instrument Control Toolbox.

Accessing Resources
If your MATLAB installation includes elements that require resources, the
SystemTest desktop includes a Resources pane that lets you access the
resources available through these toolboxes. For example, if your MATLAB
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installation includes Instrument Control Toolbox, you can see the Resources
pane, if you open it from the Desktop menu. Select Desktop > Resources to
open the pane. It will tab with the Test Vectors and Test Variables on the
lower left corner of the desktop. Resources are toolbox-specific. For example,
an Instrument resource might be configured to connect to a device over your
computer’s serial port.
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Example: Measuring a Generator’s Frequency

In this section...

“Introduction” on page 5-4

“Setting Up the Signal Generator” on page 5-5

“Setting Up the Oscilloscope” on page 5-10

“Taking the Measurement” on page 5-12

“Saving Test Results” on page 5-13

“Running the Test and Viewing Test Results” on page 5-14

Introduction
To illustrate how to use some of the Instrument Control elements in
SystemTest, this section provides a step-by-step example.

In this example a SystemTest element configures a signal generator to
produce signals of various frequencies, which are measured by an oscilloscope
configured by other SystemTest elements.

The signal generator is a Hewlett-Packard 33120A at GPIB address 5, and
the oscilloscope is a Tektronix TDS 210 at GPIB address 4. For this example,
the generator output is fed directly to the scope input. The generator will
be programmed to generate signals of 1500, 5000, and 7500 Hz, while the
oscilloscope will measure each signal’s frequency.

The following sections explain the steps in this example.
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Setting Up the Signal Generator
The first element in the test programs the generator to output signals of
various frequencies. To test at three frequencies, the test be comprised of
three test cases, i.e., three iterations. This is a one-way communication to the
generator, so you use a To Instrument element.

1 Open SystemTest from MATLAB by selecting Start > MATLAB >
SystemTest > SystemTest Desktop. You can also just type systemtest
at the MATLAB command line.

2 When SystemTest opens, ensure that the Visualize and plot saved
results by launching the Test Results Viewer check box is selected in
the Properties pane.

3 No setup is required in the Pre Test, so the elements of this test are all in
the main test, so click Main Test in the Test Browser.

4 Add an element by clicking New Test Element > Instrument Control >
To Instrument.
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The element appears in the browser as To Instrument.

5 Double-click To Instrument, rename it Set Generator, and press Enter.

6 From the Properties pane’s Select an instrument resource list,
select New Instrument Resource. The instrument resource is the
communication channel between MATLAB and your instrument, in this
case the generator at GPIB address 5.

7 In the Edit: Instrument1 dialog box, enter Generator in the Name field.

8 Click Create to create an instrument resource.

9 In the New Object Creation dialog box, select GPIB in the Instrument
object type list. Select the appropriate Vendor (in this example, ni
for National Instruments), Board index (0), and instrument Primary
address (in this example, 5).
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10 Click OK to return to the Edit: Instrument1 dialog box, where the
instrument object is now filled in and selected for this resource (GPIB0-5).

11 Click OK to apply this resource and return to the Properties pane in the
SystemTest desktop.

12 In the Command text field, enter frequency followed by a space to
separate the text from the variable that will follow. This is the command to
set the frequency of the 33120A generator, as described in the instrument’s
reference manual proved by the vendor.

13 Click Data source and select New Test Vector. The name of the
vector you create for setting the generated frequencies is called genfreq.
Enter that text in the Name field, and set the Expression field to
[1500 5000 7500], including the brackets.
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14 Click OK to return to the SystemTest desktop.

Notice that the Main Test node in the tree now says (3 Iterations).
Because you entered three values in the test vector, the test is comprised of
three iterations, one for each frequency value in the test vector.

5-8



Example: Measuring a Generator’s Frequency

15 Keep the Send variable data as setting as String. The generator is
expecting string values for its commands.

16 Set a pause value of 2 seconds. This allows the generator to settle before
you measure its output.

The element should now resemble the following figure:
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Setting Up the Oscilloscope
You use a To Instrument element, which provides a one-way communication
to the oscilloscope, to program the scope to measure frequency.

1 Add an element by clicking New Test Element > Instrument Control >
To Instrument.

2 Double-click To Instrument in the tree, rename it Set Scope, and press
Enter.

3 As before, create a new instrument resource, but this time call it Scope.
Create a new instrument object for it using Board index 0, and GPIB
primary address 4.

4 For the command text, enter measurement:immed:type frequency. This
puts the scope in the frequency measurement mode, as described in the
instrument’s reference manual provided by the vendor.

There is no test variable or pause required for this element, so the element
looks like the following figure:
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To see the resources you created for communications with your two
instruments, click the Resources tab at the bottom of the SystemTest
window. You can see the Generator and Scope resources, along with their
GPIB settings.
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Taking the Measurement
With the generator and scope set up, you can take the measurement with the
scope using a Query Instrument element, which sends the command to the
scope for taking the measurement.

1 Add an element by clicking New Test Element > Instrument
Control > Query Instrument.

2 Double-click Query Instrument in the tree, rename it Measure with
Scope, and press Enter.

3 Use the existing instrument resource called Scope, by selecting it in the
Instrument resource list.

4 Enter the command to query for a measurement by typing
measurement:immed:value? in the Instrument query command field.

5 Select Store complete response, and select the Empty input buffer
after read check box.

6 From the Interpret data as list, select String (this scope returns ASCII
strings), and select the Convert string value to a numeric result check
box.

7 From the Assign data to list, select New Test Variable. For the
oscilloscope’s frequency measurement, name the test variable scopefreq.
It needs no initial value.

The element now looks like the following figure:
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Saving Test Results
To view the results of your test, you must first specify the test variables you
want to save as test results. This is done in the Save Results Properties
pane.

1 Click Save Results in the test browser tree.

2 In the Properties pane, click New Mapping.

3 From the Test Variable list, select scopefreq. This test variable contains
the frequency measurements provided by the oscilloscope during each Main
Test iteration, as shown in the following figure:
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Running the Test and Viewing Test Results
Now that the test elements are all created, you can run the test.

1 Run your test. When the test is complete, the Test Results Viewer displays
your test results.

2 You can explore and plot your test results using the Viewer. Alternatively,
in the Data pane, right-click the name scopefreq and select Export. This
makes the variable available in your MATLAB workspace.
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3 To see the measurement results, at the MATLAB prompt type

format short g
scopefreq
scopefreq =

1501.5
5000
7500

This verifies that the signal generator is producing the expected signal
frequencies.
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Introduction

In this section...

“Overview” on page 6-2

“Data Acquisition Toolbox Test Elements” on page 6-2

Overview
This chapter describes how to use the Data Acquisition Toolbox elements
with SystemTest.

The Data Acquisition Toolbox elements provide a way to bring analog and
digital data from a data acquisition device into a SystemTest test, or to send
analog or digital data from your device. You can use these elements along
with the other elements in SystemTest to create tests for Simulink models
and other applications.

Note To use the Data Acquisition Toolbox elements, you need a license for
Data Acquisition Toolbox. These four elements will not appear in SystemTest
without this license.

Data Acquisition Toolbox Test Elements
Data Acquisition Toolbox provides four elements that you can use in
SystemTest:

• Analog Input — For reading analog data from your data acquisition device

• Analog Output — For sending analog data to your data acquisition device

• Digital Input — For reading digital data from your data acquisition device

• Digital Output — For sending digital data to your data acquisition device

You can configure each test element to communicate with your data
acquisition devices for sending or receiving digital or analog data.
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Example: Testing a Voltage Regulator

In this section...

“Introduction” on page 6-3

“Sending Analog Stimulus Data to the DUT” on page 6-4

“Enabling the DUT with Digital Data” on page 6-7

“Receiving Analog Response Data from the DUT” on page 6-9

“Disabling the DUT with Digital Data” on page 6-10

“Performing Data Analysis” on page 6-12

“Defining Post Test Elements” on page 6-13

“Saving and Viewing Test Results” on page 6-14

Introduction
To illustrate how to use some of the Data Acquisition Toolbox test elements
in SystemTest, this section provides a step-by-step example. The example
shows how to use the elements that send data to a device under test (DUT)
and receive data from a device under test, using both analog channels and
digital lines.

This example samples the response of a 5-V voltage regulator that is
stimulated with three different voltages of 4, 5, and 7.5 volts. The regulator
has an enable function controlled by a digital signal. In this example, you
collect 22,000 samples per second of the DUT response for 2 seconds.

All data going to and from the DUT is handled by a National Instruments
PCI-6035E data acquisition card. The example uses this card’s analog output
for the DUT stimulus, analog input for capturing the DUT response, and
digital output for controlling the DUT’s enable line. The test configuration is
shown in the following figure:
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The following sections contain the steps in this example.

Sending Analog Stimulus Data to the DUT
Stimulus data is sent to the DUT from an analog output channel of your
data acquisition card.

1 Open SystemTest in MATLAB by selecting
Start > MATLAB > SystemTest > SystemTest Desktop.
You can also type systemtest at the MATLAB command line.

2 This example does not use the Pre Test section, so select the Main Test
section in the Test Browser pane.

3 Add an Analog Output element by selecting New Test Element > Data
Acquisition > Analog Output.
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The new element appears in the browser tree, and its properties appear in
the Properties pane. SystemTest scans your computer for installed data
acquisition adaptors and devices. This can take several seconds.

4 Double-click the new Analog Output node in the browser tree, and enter a
new name for this element, such as Stimulate DUT.

5 Since we have three test cases, we need to create a test vector containing
the three voltage settings to test against. Click the Test Vectors tab. The
voltage values for the stimulus to the DUT are held in a test vector. Click
New to create a new test vector.

6 Click the name TestVector1 and enter a new name for your vector, such
as DUTstimulus.

7 Click the default 1 : 1 : 10 entry in the Expression column, and
replace it with the values for your test: [4, 5, 7.5] (be sure to include the
brackets) and click OK. Notice that because there are three values in your
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vector, the browser tree now indicates that the Main Test will run three
iterations. Each iteration will use one of the three values in the vector for
the DUT stimulus voltage.

8 In the Properties pane, select the adaptor and device to use for the test.
This example uses the nidaq adaptor, and the device is a PCI-6035E.

9 The example hardware configuration uses the card’s analog output
hardware channel 0 to provide the DUT’s stimulus. So select the check box
for this channel. The element will generate signals of 4, 5, and 7.5 volts, so
keep the default output range of [-10.0 10.0].

10 From the Data source list, select the DUTstimulus test vector.

11 Enter a value of 1 for Output rate. You are using a single static value
rather than a sampled waveform, so this is not critical.

12 Enter a value of 1 for Number of times to output data. The card will
hold its last programmed value, so you need to send it only once.
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The Properties pane now looks like the following figure:

Enabling the DUT with Digital Data
To send a digital enable signal to the DUT, use a digital output element.

1 Select New Test Element > Data Acquisition > Digital Output.

2 Double-click the new Digital Output element in the browser tree, and type
a new name for this element, such as Enable DUT.

3 Click the Test Variables tab.

4 Click the New button to create a new variable. You will create two
variables: one for enabling and one for disabling the DUT.

5 Click the name Var1, and replace it with the text DUTenable.
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6 Click its empty Initial Value entry, and enter 1.

7 Repeat steps 4 to 6 to create a second test variable, but name it DUTdisable
with an initial value of 0.

8 In the Properties pane for the Enable DUT element, select the adaptor
and device for sending this data. Again, you are using the nidaq adaptor,
and the device is a PCI-6035E.

9 The hardware configuration uses the card’s digital output port 0, line 3 for
the enable signal, so select the check box for this line.

10 From the Data source list, select the variable DUTenable.

The Properties pane now looks like the following figure:
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Receiving Analog Response Data from the DUT
The next element in the test samples the output from the DUT and assigns
the acquired data to a test variable.

1 Select New Test Element > Data Acquisition > Analog Input.

2 Double-click the new Analog Input element in the browser tree, and enter
a new name for this element, such as DUT Response.

3 In the Properties pane, select the adaptor and device to use for the test.
This example uses the nidaq adaptor, and the device is a PCI-6035E.

4 The hardware configuration uses the card’s analog input hardware
channel 3 to read the DUT’s response, so select the check box for this
channel. The expected signal will be about 5 volts, so keep the default
output range of [-10.0 10.0].

5 Set a sample rate of 22000. Because of hardware limitations, the actual
sample rate may not exactly match the value you specify.

6 In the Acquire field, specify to acquire data for 2 seconds. Set seconds in
the unit list to the right of the value field.

7 In the Assign data to field, select New Test Variable from the list. This
is where you specify what test variable to assign the acquired data to. The
Edit dialog box appears.
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8 Enter a name for the test variable, such as DUTresponse, then click OK
to create the test variable.

The Properties pane now looks like the following figure:

Disabling the DUT with Digital Data
The next step is to disable the DUT with a digital output element that turns
off the DUT’s enable line. This element is similar to the Enable DUT element,
except it sends a different value to the DUT.
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1 Select New Test Element > Data Acquisition > Digital Output.

2 Double-click the new Digital Output element in the browser tree, and
enter a new name for this element, such as Disable DUT.

You already created the test variable DUTdisable, which you will use in
this element.

3 In the Properties pane for the Disable DUT element, select the adaptor
and device for sending this data. Again, you are using the nidaq adaptor,
and the device is a PCI-6035E.

4 The hardware configuration uses the card’s digital output port 0, line 3 for
the enable signal, so select the check box for this line.

5 From the Data source list, select the variable DUTdisable.
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The Properties pane now looks like the following figure:

Performing Data Analysis
At this stage, you might perform any analysis or visualization routines on the
data generated by the DUT. You can do this in a MATLAB element.

1 Select New Test Element > MATLAB.

2 Double-click the new MATLAB element in the browser tree, and enter a
new name for this element, such as Process Data.

3 In the MATLAB Script edit field of the Properties pane, enter any
MATLAB code that you need for analyzing your test variables. You
might be interested in measuring ripple, noise, regulation, or many other
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characteristics. You can access the DUT response by referring to the test
variable DUTresponse. The stimulus data is available in the test variable
DUTstimulus.

The following figure shows a MATLAB element with only some comments
added in the Properties pane.

Defining Post Test Elements
In this example, it is recommended to include an element in the Post Test
section to disable the DUT.

1 Click the Post Test section in the browser tree.

2 Create a digital output element set up like the element you made in
“Disabling the DUT with Digital Data” on page 6-10.
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With the extra Disable DUT element, the test now looks like the following
figure:

The Post Test section of the test could also perform any analysis that requires
completion of all the iterations of the Main Test.

Saving and Viewing Test Results
Before running a test, you must specify which test variables you want to save
as a test result. In the Save Results Properties pane, you select the test
variable that you want to save and map it to a test result name.

Saved test results will be viewable with the Test Results Viewer. To launch
the Test Results Viewer, click on the test name in the Test Browser. In the
Properties pane, make sure the Visualize and plot saved results by
launching the Test Results Viewer option is checked.
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Using the Image Acquisition
Toolbox Element

Image Acquisition Toolbox includes a SystemTest element that you can use to
bring live video data into a SystemTest test.

Introduction (p. 7-2) Introduces the Image Acquisition
Toolbox element

Example: Acquiring Video Data in
a Test (p. 7-3)

Shows how to acquire video data
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Introduction
This chapter describes how to use the Image Acquisition Toolbox element
with SystemTest.

The Image Acquisition Toolbox element, called Video Input, provides a way to
acquire live video data in a SystemTest test. You can use this element along
with the other elements in SystemTest to create tests for Simulink models
and other applications.

To learn how to use the Image Acquisition Toolbox element in SystemTest, see
“Example: Acquiring Video Data in a Test” on page 7-3.

Note To use the Image Acquisition Toolbox element, you need a license
for Image Acquisition Toolbox. The Video Input element will not appear in
SystemTest if you do not.
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Example: Acquiring Video Data in a Test

In this section...

“Adding the Video Input Element to a Test” on page 7-3

“Saving and Viewing Test Results” on page 7-8

“Running the Test” on page 7-9

Adding the Video Input Element to a Test
This example illustrates how to use the Video Input element in SystemTest.
The example uses the Video Input element to acquire a single frame of video
for each iteration of the test and uses the MATLAB element to display the
acquired image.

The first step is to add the element, as shown in this section. The two
following sections contain the remaining steps.

To create a test using the Video Input element:

1 Open SystemTest by selecting Start > MATLAB > SystemTest >
SystemTest Desktop in MATLAB. You can also just type systemtest at
the MATLAB command line.

2 In the SystemTest desktop, start to create your test by selecting Main Test
and adding the Video Input element. In the Test Browser, click New Test
Element > Image Acquisition > Video Input.
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SystemTest adds the Video Input element to the Main Test section of the
test and displays the Properties pane for the Video Input element. (You
can also add elements to the Pre Test or Post Test sections of a test but
this example does not require it.)

In the following figure, note the red x in the Video Input element icon in
the Test Browser. This red x indicates that the element is in an error state.
SystemTest outlines the required fields in red in the Properties pane.
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3 Specify the device you want to use to acquire image data in the Properties
pane for the Video Input element. You must specify the name of the adaptor
you want to use in the Adaptor field, which is a required field. (SystemTest
uses red outlining to indicate required fields that are not filled in yet.)
SystemTest can detect any image acquisition devices supported by Image
Acquisition Toolbox that are connected to your system and fills in this
field with a default value based on the alphabetical list of devices, if one
is available. For our example, in the figure, SystemTest sets the Adaptor
field to winvideo. If your system has other adaptors that can connect to
devices, select the adaptor that you want to use from the Adaptor list.

After the Adaptor field is set, SystemTest fills in the Device, Video
Format, and Selected Source fields with default values. SystemTest
populates the drop-down lists associated with each field with all available
options for the field. Adaptors can support multiple devices and devices
can support multiple formats. SystemTest preselects the default values for
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these fields but lists all available options in the drop-down lists associated
with these fields. The following figure shows the list for the Video Format
field:

4 Specify the number of frames you want to acquire at each iteration of the
test in the Number of frames field, which is a required field. For this
example, we only need to acquire one frame for each iteration, so set this
field to 1.

5 Specify the name of the SystemTest test variable that the acquired video
data will be assigned to at each iteration. This is a required field. You can
select a test variable from the list or create a new test variable by selecting
New Test Variable.
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If you select New Test Variable, SystemTest opens the Edit dialog box.
Assign a name to the test variable, or accept the default name, and click
OK. You do not need to assign the test variable an initial value.

SystemTest adds the new test variable to the list in the Test Variables
pane.

6 Optionally, verify the Video Input element settings by clicking the Preview
Window button. SystemTest opens a Video Preview window and displays a
live video stream from your camera. You can use this to verify that your
hardware is configured correctly. You should close the preview window
before running the test.

7 To complete this example test, add a MATLAB element to the Main Test
section. In this MATLAB element, call the MATLAB image function to
display the image frame acquired at each iteration.
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This completes this example test illustrating how to incorporate image data
into SystemTest. In a real testing application, you can define test vectors that
determine the number of iterations of your test that SystemTest performs.
You can also compare test variables against defined limits in the Limit Check
element and specify pass/fail criteria.

Saving and Viewing Test Results
Before running a test, you must specify which test variables you want to save
as a test result. In the Save Results Properties pane, you select the test
variable that you want to save and map it to a test result name.
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Saved test results will be viewable with the Test Results Viewer. To launch
the Test Results Viewer, click the test name in the Test Browser. In the
Properties pane, make sure the Visualize and plot saved results by
launching the Test Results Viewer option is selected.

Running the Test
To run the test, do one of the following:

• Click the Run button.

• Select Run > Run.

• Press the F5 key.

While the test executes, SystemTest reports on the progress of the test in
the Run Status pane.

After the test runs, the Test Results Viewer will launch. In the Viewer, select
the type of plot you want to create. For this example, select Image Plot from
the Plots menu or click the Image Plot button in the Test Results Viewer
toolbar.
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SystemTest and Distributed Computing Toolbox Integration
You can distribute SystemTest tests across multiple computers or processors.
You can set up a test and then distribute Main Test iterations as tasks, which
are performed concurrently by different workers. This can help speed up the
total time the test takes to execute.

Note To distribute tests in SystemTest, you need a license for Distributed
Computing Toolbox.

You set up a distributed test as you would set up any test, using the
SystemTest desktop. Then you use the Distributed tab on the Test
Properties pane to set up the test distribution.

To access the distributed testing functionality in SystemTest, do one of the
following:

• Select your test name in the Test Browser. This is the top node in the
Test Browser, that lists the name you give the test when you save it, or
“Untitled,” if you have not saved it yet. Then click on the Distributed
tab in the Test Properties pane.

• Select Tools > Distributed Testing on the SystemTest menu. This opens
the Distributed tab.

Note that if you do not have Distributed Computing Toolbox installed, the
tab displays a message indicating you cannot use the distributed testing
functionality.

Note To see a diagram that shows how distributed testing with SystemTest
works and illustrates the relationship between SystemTest, the scheduler,
and the workers, see “Running a Distributed Test” on page 8-14.
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Enabling Distributed Testing
You must select the Enable Distributed Testing check box to distribute a
test. Once enabled, the rest of the fields on the Distributed tab are activated.

The check box is not enabled by default on new tests. However, once you
have set up a distributed test, if you save and close a test with the check box
enabled, it will reload in the enabled state.

The Main Test node on the Test Browser indicates if your test is set up
to be distributed. For example, if you have a distributed test containing 60
iterations, the node displays Main Test (60 Iterations) – Distributed, as
shown in the following figure.
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Selecting a User Configuration
You or an administrator must set up a user configuration in Distributed
Computing Toolbox before distributing tests in SystemTest. The user
configuration determines certain administrative options, such as what
scheduler is used. You can use the MathWorks job manager that comes with
Distributed Computing Engine, and the local scheduler that comes with
Distributed Computing Toolbox. You can also use a third-party scheduler, such
as Windows CCS, Platform Computing LSF, mpiexec, or a generic scheduler.

In the User Configuration field on the Distributed tab, select the user
configuration that will be used when you distribute tests.

• The Default option indicates the configuration that is designated as the
default in Distributed Computing Toolbox. The name of the configuration
appears in parentheses.

• If you have any other configurations defined, they will appear in the
drop-down list under Default. Either use the default, or click the second
radio button and choose a user configuration from the list.

8-5



8 Distributing Tests Using Distributed Computing Toolbox Integration

In the following example, this user has several different schedulers and has
a separate user configuration for each scheduler. In this example, the user
configurations are named for the schedulers they use.

User configurations contain other information in addition to scheduler
selection, and are used to define other distributed computing parameters.
See Programming with User Configurations in the Distributed Computing
Toolbox documentation for details on setting up the user configuration.

If you load a test containing a user configuration that no longer exists, this
option will be in an error state. You can correct the error by selecting a valid
user configuration.
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Setting Up File Dependencies
Use the File Dependencies table to indicate files or folders of files to be
copied to the worker machines. If the worker machines need to access files
that your test is dependent on, you can add the names of the files or directories
of files as dependencies in SystemTest and they will be copied to each worker.

Note: There is overhead in copying files for each task. If there are files that
can be accessed from a shared location by the worker machines, use Path
Dependencies instead. For example, if you use a Simulink element that
references a large model available from a shared network folder, you should
set a path dependency to the directory containing your model.

File dependencies can be defined in the File Dependencies table, as
described below, or can be defined in the user configuration that is set up in
Distributed Computing Toolbox. If there are any file dependencies specified
by the currently selected user configuration, they will also be listed in this
table, but will appear in italics and are not editable here. File names you
enter through SystemTest appear in regular text and are editable here.

To set up a file dependency:

1 Click the File Dependencies tab within the Distributed tab.

2 Double-click the entry row in the table (the top row).

The row becomes a text field.

3 Do either:

• Type the full path and file or folder name in the field, and then press
Enter.

• Click the browse button in the entry row, browse to the file or folder, then
click Open in the browse dialog box.

The dependency you entered then appears as a new row in the list.
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The example below shows file dependencies for an M-file and a small model
to be copied to the worker machines.

If you want to delete a file dependency, select it and click the Delete button.
You can delete only dependencies added in SystemTest. You cannot delete any
that are specified by the user configuration.

8-8



Setting Up Path Dependencies

Setting Up Path Dependencies
Use the Path Dependencies table to indicate directories to be added to the
workers’ MATLAB path. If the worker machines need to access certain files
during the test, you can add the directories here. These directories are added
to the workers’ MATLAB path such that the necessary files can be located.
For example, if you use a Simulink element that references a large model
available from a shared network folder, you should set a path dependency to
the directory containing your model.

Note: If there are files that cannot be accessed from a shared location, use
File Dependencies instead.

You can enter path dependencies in the Path Dependencies table, as
described below, or in the user configuration that is set up in Distributed
Computing Toolbox. If there are any path dependencies specified by the
currently selected user configuration, they will also be listed on this tab, but
will appear in italics and are not editable in SystemTest. Paths you enter
through SystemTest appear in regular text and are editable here.

To set a path dependency:

1 Click the Path Dependencies tab within the Distributed tab.

2 Double-click the entry row in the table (the top row).

The row becomes a text field.

3 Do either:

• Type the path in the field, and then press Enter.

• Click the browse button in the entry row, browse to the directory, then
click Open in the browse dialog box.

The dependency you entered then appears as a new row in the list.
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In the following example, because the model is very large the user set up a
path dependency for the directory containing the model that the test uses.

Notice in this example that the path is listed twice, once in Windows format
and once in UNIX or Linux format. If you have a heterogeneous cluster that
contains both Windows and UNIX or Linux worker machines, you need to add
the path twice so that all workers can use it.

8-10



Setting Up Path Dependencies

Note Path dependencies must be listed in the format supported by the type
of worker machines the cluster contains, as shown in the previous figure
(which shows both styles). Also, for Windows machines that cannot be directly
accessed by all the workers, you need to specify the path as a UNC path.

If you want to delete a path dependency, select it and click the Delete button.
You can delete only dependencies added in SystemTest. You cannot delete any
that were specified by the user configuration.
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Distributing Iterations Across Tasks
The Distribution of main test runs across tasks option on the
Distributed tab determines the distribution of Main Test iterations into
tasks that the workers perform. The calculation is based on the total number
of iterations your test contains.

By default, the Default option is selected and the text in parentheses
shows the number of iterations per task and number of tasks. The default
is calculated by dividing the number of iterations in your test by 32 (an
approximation based on a setup of 8 workers, with a target of 4 tasks per
worker), and using the closest number to that. For example, if your test has
90 iterations, the default will be 3 iterations per task and 30 tasks, as shown
below.

If you run your test and this does not seem efficient, you can change the
number of iterations per task and number of tasks. To change it:

1 Select the second option. The number field becomes editable.

2 Enter the number of iterations per task you want to use.
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3 Press Enter.

The number of tasks is then calculated (total number of iterations divided
by number of iterations per task) and shown in parentheses. For example,
if you had the same test with 90 iterations, but changed iterations per
task to 6, you get 15 tasks.
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Running a Distributed Test
You run a distributed test as you would run any other test, by clicking the
Run button in the SystemTest toolbar.

When you run a distributed test:

• Pre Test executes once, on the client machine (the machine from which
you run the test).

• Main Test iterations execute on the cluster of worker machines defined
by the user configuration.

• SystemTest waits for the distributed test to complete.

• If there are errors when the distributed test iterations run, only the first
error from the tasks will be reported to the Run Status pane in SystemTest
once all tasks have completed.

• At the end of each Main Test iteration, test results are saved and returned
to the client machine once all Main Test iterations have finished executing.

Note Because Main Test iterations run across a number of tasks, there is
no guarantee as to the order the tasks (Main Test iterations) will execute.
Tests should not be written with the assumption that iterations will execute
in a fixed order.

Also, because Pre Test runs on the client machine, and tasks run independent
of each other, Main Test iterations should not rely on data persisting across
multiple iterations.

• Post Test executes once on the client machine, after Main Test executes or
has errored while running.

• Test execution reports are generated at the end of the test, if enabled by
the test.

• Generated plots are not shown on the client machine while the test
runs, but are captured and displayed in the Test Report. Note that plots
generated on worker machines will only reflect information generated as
part of the task. Plotting multiple data points or lines on a single plot will
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only reflect the data pertaining to iterations executed as part of a single
task.

Note that MATLAB and SystemTest remain in a busy state until the
distributed test is done running or is stopped.

Caution It is recommended that you do not run a test containing
hardware-related elements in distributed mode. That includes the Image
Acquisition Toolbox element, the Data Acquisition Toolbox elements, and the
Instrument Control Toolbox elements. These elements will likely error out
because the connected hardware will not be available on the workers.

The following diagram illustrates the relationship between SystemTest, the
scheduler, and the workers. Task 1 to Task X and Iteration 1 to Iteration
N are determined by what is shown in the Distribution of main test
runs across tasks section in the Distributed tab. For example, if the
Distribution of main test runs across tasks for a test with 90 iterations
is set to Default (3 iterations per task, 30 tasks), that means your test
will execute 3 iterations for each of 30 tasks. In this case, Task 1 might run
iterations 1, 2, and 3, and Task 2 might run iterations 4, 5, and 6, etc.
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Example: Distributing a Test
The following general example shows how you can distribute any test you
have created.

You create and set up a distributed test as you would set up any test, using
the SystemTest desktop. If you determine that the test takes a long time to
execute, you may benefit from distributing it. You then use the Distributed
tab on Test Properties to set up the test distribution.

To distribute a test:

1 Select your test name in the Test Browser. Then click the Distributed
tab in the Test Properties pane.

2 On the Distributed tab, select the Enable Distributed Testing check
box to enable distributed testing and activate the other options on the tab.

3 SystemTest uses the user configurations set up in Distributed Computing
Toolbox. User configurations identify various settings, such as which
scheduler to use.

In the User Configuration section, keep the default user configuration, or
select the second radio button and choose a different configuration from the
drop-down list.

For more details, see “Selecting a User Configuration” on page 8-5.

4 If your test is dependent on files, such as models, M-files, or MAT-files, in
order to execute, you need to specify the dependent files so that the worker
machines can access the files while the test is running.

If there are files that need to be copied onto the worker machines, use the
File Dependencies tab. If there are files available on a shared network
location that need to be accessed by the worker machines, use the Path
Dependencies tab instead. For example, if you use a Simulink element
that references a large model available from a shared network folder, you
should set a path dependency to the directory containing your model.

Enter the necessary file or path dependencies into the respective tabs by
double-clicking the top row in the tables. For more details, see “Setting
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Up File Dependencies” on page 8-7 and “Setting Up Path Dependencies”
on page 8-9.

5 SystemTest will calculate number of iterations per task for you, or you can
specify that, in the Distribution of main test runs across tasks section.

Use Default, or change it by selecting the second option, which enables the
number field. Enter the number of iterations per task you want to use and
press Enter or click outside the field.

For details on how these values are calculated, see “Distributing Iterations
Across Tasks” on page 8-12.

6 Run the distributed test as you would run any other test, by clicking the
Run button in the SystemTest toolbar.

For information on what happens when you execute a distributed test, see
“Running a Distributed Test” on page 8-14.
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This chapter explains how to use the Test Results Viewer to explore and
analyze your test results.
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Viewing Your Test Results (p. 9-7) How to render plots of your saved
test results

Refining Your Test Results (p. 9-28) How to use constraints to filter the
test results shown in your plots

Viewing Simulink Time Series Data
(p. 9-37)

How to plot Simulink values with
time data

Saving and Reloading Test Results
(p. 9-41)

How to save and reload your test
results and work you do in the
Viewer



9 Using the Test Results Viewer

Before You Begin
The examples in this chapter use saved test results from the Throttle demo.
You can follow the explanations by loading and running the Throttle demo
from the MATLAB command line. The Throttle demo is configured to open
the Test Results Viewer upon completing a test.

See the SystemTest Demos page for an explanation of the Throttle demo.

Note This demo will not be listed if you do not have Simulink installed.

To prepare for the rest of this chapter:

1 Start MATLAB.

2 In MATLAB, select Start > Demos to open the Help browser opens.

3 Expand the MATLAB list from the left frame of the browser.

4 Click SystemTest. The SystemTest demos open in the right browser frame.

5 Under Simulink, click Validating a Throttle Body Model. An overview
of the demo opens.

6 Click the link Open the demo in the SystemTest desktop at the bottom
of the page.

Alternatively, you can enter the following command at the MATLAB
command line:

systemtest demosystest_throttle

After the SystemTest desktop appears, run the loaded test. Do one of the
following:

• Click the Run button.
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• Press the F5 key.

• Select Run > Run.

SystemTest runs the Throttle demo test, saves the specified test results, and
opens the Test Results Viewer when it finishes.
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Note The most common use case is to have the Viewer open automatically
after a test run, as described here. But you can also open the Viewer directly
from MATLAB by typing stviewer at the MATLAB command line. The
Viewer would open in an empty state. To open test results then, use the File
> Load Test Results menu command.
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A Quick Tour of the Test Results Viewer
The Test Results Viewer is organized to show you the test vectors you specified
as inputs to your test, the results saved from your test, and tools you can use
to plot and examine your test results.
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The test results and test vectors from your test are available in the Data
pane, which is a compact data browser. You choose your plot type, set your
display options to include what appears on the different axes, and plot your
data. The plotting tools let you select data from the plot to examine, and
you can see the actual values that resulted in individual plot points in the
Current Iteration pane, which will open automatically when you select a
plot point. If this pane is not visible, select Desktop > Current Iteration.
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“Viewing Your Test Results” on page 9-7, “Refining Your Test Results” on page
9-28, and “Viewing Simulink Time Series Data” on page 9-37 explain how to
use the Test Results Viewer to plot and examine your test results.
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Viewing Your Test Results

In this section...

“Reserved Keywords” on page 9-7

“Browsing Results” on page 9-7

“Generating Plots” on page 9-8

“Exploring Plots” on page 9-15

Reserved Keywords
The Test Results Viewer has several reserved keywords that you cannot use
as a test result name or as a derived result name. These keywords are:

• time

• testrun

• testruns

• metadata

• data

If any of these keywords are used as a test result name, they will be prepended
with "st_" when loaded in the Test Results Viewer. If you try to use these
keywords as a derived result name in the Test Results Viewer, you will get
an error message.

Browsing Results
“Viewing Test Results in the Test Results Viewer” on page 1-40 notes that the
Test Results Viewer contains a data browser within the Data pane. This area
of the viewer is one of the first things you see when the Test Results Viewer
opens. It shows you the test variables and test vectors your test used, and it
shows information about their values in the Data Statistics area.

These data statistics summarize the values of a test result or test vector
across all of the tests. For example, the Throttle demo varies the parameters
for mass, damping, and stiffness of a Simulink model. Test vectors vary
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Simulink block parameters for 90 test iterations, and SystemTest saves
how these changes affect the position of a simulated throttle opening in the
position_sim test result.

If you click position_sim in the Results area of the Data pane, the Data
Statistics area shows you a summary of statistical information for all 90
iterations. In this example, you have not defined any constraints on your data,
so statistical information for the constrained and unconstrained columns is
the same. See “Creating and Applying Constraints” on page 9-28.

“Generating Plots” on page 9-8 explains how you can further explore your
test results.

Generating Plots
The Test Results Viewer has a plotting capability that helps you understand
your test results. You can determine how values of different inputs (test
vectors) affect the overall test results.

To generate any plot:

1 Click the button corresponding to the type of plot you want to generate.
The plot buttons are below the menu bar. For example, click the Line Plot
button. See “Choosing a Plot” on page 9-13 for an explanation of your
choices. You can also use the Plots menu to generate plots.

9-8



Viewing Your Test Results

2 Choose the data to use for your X-axis and Y-axis in the Define Plot pane.
For example, select *Auto* from the X Axis list and position_sim from
the Y Axis list to show the simulated throttle position trajectories at each
test iteration. See “Choosing a Plot” on page 9-13 to understand which
data types are available on each axis.

3 Choose a different plot type if you do not want to use the default. To choose
a different plot type:

a Click Plot type in the Define Plot pane.
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b Click the plot type you want to use. For the Throttle demo example,
use the default sine wave.

4 Click the Plot button. The Test Results Viewer renders a plot based on
your selections.

Each line in the plot represents a test iteration. If it appears that there are
not as many lines as you had test iterations, it is possible that two or more
iterations generated similar enough results that they overlap.

Now you can analyze the plot. To help you with this task, you can:

• Explore the plot using the plotting tools available to you as explained in
“Exploring Plots” on page 9-15.

• Refine what results are shown in your plot as explained in “Refining Your
Test Results” on page 9-28.
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Plotting Grouped Test Vectors
You can plot grouped test vectors on both the X and Y axes of scatter plots.
Using grouped test vectors in plot configurations allows you to see the
relationship between the grouped vectors.

The following figure shows an example of a test that has two grouped test
vectors, TestVector1G and TestVector2G. The scatter plot allows both
grouped vectors to be shown in the plot, one on each axis. That is useful for
Monte Carlo simulation testing. For example, if you have two vectors that
vary the mass of two different components in a model, you could see them in
relation to each other.
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To plot two grouped test vectors in the viewer:

1 Select Scatter as your Plot type.

2 Select the first grouped test vector from the X Axis list.

3 Select the second grouped test vector from the Y Axis list.

4 Click the Plot button.

You will see a plot similar to the one shown above in which you can see how
the two test vectors relate to each other.

Using Grouped Test Vectors as Distinguishing Variables in Subplots

You can also use grouped test vectors as distinguishing variables in subplots.
You can select them in the Subplot drop-down lists next to the labels show
and and.

For example, in the example shown above, if a test variable TestVariable1
were plotted against a non-grouped test vector TestVector1Ungrouped,
TestVector1G could be used to distinguish the resulting scatter points using
different marker colors and TestVector2G could be used to distinguish them
by different subplot rows. The grouped test vectors would appear in the
subplot drop-down lists to allow this configuration.

Choosing a Plot
There are six types of plots. The line plot, mesh plot, and time series plot
types have additional subtypes available. Additionally, the Test Results
Viewer has rules for determining which test results you can plot on the X-axis,
Y-axis, and Z-axis. These rules vary by plot type. The following table explains
these selections:

9-13



9 Using the Test Results Viewer

Plot Description

Line Standard line plot of Y versus X. Represents scalar or vector
data. The default is a wave line, but you can choose a square
line sub type. The following data are allowed on each axis:

• X — Numeric test vectors

• Y — Numeric test results

Surf Wireframe surf plot based on X, Y, and Z coordinates.
Optional surface sub type available. The following data are
allowed on each axis:

• X — Numeric test vectors

• Y — Numeric test vectors

• Z — Numeric test results

Scatter Standard scatter plot of X and Y where either axis can have
numeric test vectors or numeric test results.

Time Series Plots time series data Y against time (X is always time).
Designed to represent Simulink time series object data. The
default is a wave line, but you can choose a square line sub
type. See “Viewing Simulink Time Series Data” on page
9-37 for more information about this plot type.
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Plot Description

Waterfall Waterfall plot for vectors or time series. One vector or time
series can be displayed on each waterfall plot. The meaning
of the X, Y, and Z axes is as follows:

• X — Is automatically selected to be “*Auto*” if the Z axes
is assigned to a vector-valued test result, or “Time” if Z
axes is assigned to a time series test result.

• Y — You can select either Test Run or Iteration. In
the former case, if a test is excluded by application of
constraints a gap will appear in the waterfall plot at the
Y position corresponding to that test. In the latter case,
lines representing the test result displayed on the Z axis
are always placed in consecutive Y positions.

• Z — You can select either a single vector-valued numeric
test result or a single time series test result.

Image Lets you look at individual frames from an image sequence
saved during a test iteration. Data must be a supported
MATLAB Image format, and must be numeric test results
whose size is compatible with an image, namely that:

• It has three or four dimensions.

• The third dimension has a length of 1 or 3.

Exploring Plots
This section describes the tools the Test Results Viewer makes available to
help you understand its generated plots. It contains the following topics:

• “Plotting Tools” on page 9-16 describes the tools available to help you
examine and understand the contents of a generated plot.

• “Viewing Individual Iteration Values” on page 9-16 shows how to focus on
specific iteration test results in a plot.

• “Highlighting Values in Your Plot” on page 9-20 shows how to distinguish
test results in a plot.
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• “Exposing Overlapping Plot Lines” on page 9-24 explains how you can view
individual lines in a plot that shows multiple test result values as the same
line.

Plotting Tools
The Test Results Viewer integrates the MATLAB Figure Toolbar, which
lets you examine and distinguish the test results shown in your plots. See
“Plotting Tools—Interactive Plotting” and “Data Exploration Tools” in the
MATLAB Graphics documentation for more information.

In addition, the viewer also supports the desktop arrangement tools available
in the MATLAB editor. See “Arranging the Desktop — Overview” in the
MATLAB documentation.

The Test Results Viewer adds the following features to the MATLAB Figure
Toolbar:

• Test run selection — Lets you click different test runs in the plot and see
the test vector and test results for that iteration in the Current Iteration
pane. “Viewing Individual Iteration Values” on page 9-16 shows an example
of how to use this.

• Lock the plot — Prevents constraints from changing the test results
displayed in the plot.

Viewing Individual Iteration Values
Every test iteration has its own representation in a plot unless you screened
it out with a constraint (“Refining Your Test Results” on page 9-28 explains
constraints). By clicking a line, marker, or surface in a plot with the test run
selection tool, you can see the information associated with that test iteration
in the Current Iteration pane.

For example, “Generating Plots” on page 9-8 demonstrates how to generate
a plot showing all test iteration results of the Throttle demo. You can use
the Test Results Viewer plotting tools to zoom in on areas of the plot and
determine which iteration was responsible for the result.

1 Click the Zoom In button.
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2 Move the mouse pointer over an area of the plot you want to investigate
further.

3 Left-click your mouse or click and drag over the area you want to see. The
plot redraws to show this area.

You can repeat zooming in until you have the level of detail you want.
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4 To turn off the Zoom, click the Zoom In button again.

5 Click the Select an iteration button in the Figure Toolbar.

6 Click one of the plotted lines in the line plot. The viewer marks the line.
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The viewer simultaneously populates the Current Iteration pane with
information about the values for all test vectors and test results for your
selected test iteration. This lets you easily see what test conditions generated
a specific result.
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Highlighting Values in Your Plot
The Test Results Viewer lets you further distinguish your test results for any
given plot by letting you control how a plot renders the data on each axis.
This is useful in deciphering test results on a plot—especially when the initial
plot has a large number of test results closely grouped together. This section
explains how you use the Define Plot pane to modify the appearance of your
plot without modifying the underlying test results. (See “Refining Your Test
Results” on page 9-28 for information about modifying the test results used
to render a plot.)

The Define Plot pane provides four ways to distinguish plotted test results:

• Color

• Markers

• Subplot rows

• Subplot columns

For example, the Throttle demo shows the effect of variations in mass,
damping, and stiffness on a component of a Simulink model. The plot you
generated in “Generating Plots” on page 9-8 shows test results for of all test
iterations, but it is impossible to determine how changes to each test vector
affected this outcome. To distinguish the test results on the plot:

1 Zoom in on an area of the line plot so that you can see individual test
iterations (as explained in “Viewing Individual Iteration Values” on page
9-16).
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2 In the Define Plot pane, click Show > Damping.

3 Select color from the as list.

4 Click the Refresh Plot button. The plot lines change to show a range
of colors.
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You now have some idea how damping has affected the test results. You have
a cluster of blue, green, and red indicating that damping is the same value in
each cluster, which you can confirm by using the test selection tool to choose
lines and by viewing the value for the Damping test vector in the Current
Iteration pane.

You can modify the appearance of another set of test vectors to further
understand the test results. For example, the menu below Damping can be
used to distinguish variations in mass with markers.

1 Click the menu next to and.

2 Select Mass from the list.
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3 Click the menu next to as and select marker type.

4 Click the Refresh Plot button.

The viewer redraws the plot to show markers distinguishing variations in
mass. Notice how each cluster of lines has its own unique color and marker,
which shows that variations in damping and mass have a visible effect when
you run the model.

You can add two more rows using the + button in the Define Plot pane to
distinguish your test results further.
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Note These colors and markers do not necessarily show the same value
throughout the overall plot. The viewer cycles through all colors and markers
in the palette making it possible for different test result values to have the
same color or marker.

Exposing Overlapping Plot Lines
It is possible for plot lines and points to overlap and appear undistinguishable.
When multiple lines overlap, you can create subplots to distinguish the data
points.

For example, if you create a line plot for the Throttle demo with the X-axis
set to *Auto* and the Y-axis set to position_sim, the Test Results Viewer
renders a plot with plot lines in close proximity.

9-24



Viewing Your Test Results

This plot has 90 lines that are too close together to be able to discern clear
patterns. You can use the Define Plot pane to distinguish plots of test results
by placing the generated lines of a test in individual subplots. Each subplot
shows the test vector values associated with the test results being plotted.
The number of runs per test vector value determines how many subplots you
can generate. Using the Throttle demo, you can generate subplots based on
changes in damping, mass, or stiffness. For example, what effect did changes
in mass have on these test results? To show its effect:

1 In the Define Plot pane, select Show > Mass.
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2 Select subplot rows from the as list.

3 Click the Refresh Plot button.

The viewer now shows three subplot diagrams, one for each value of the
Mass test vector.
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Refining Your Test Results

In this section...

“Creating and Applying Constraints” on page 9-28

“Plotting Single Iterations” on page 9-35

Creating and Applying Constraints
This section explains how you create and apply constraints to restrict the test
results to a subset of test iterations. You also see how to use a constraint
to walk through a set of test results.

Constraints are a Test Results Viewer mechanism that screen out test result
values. Constraints can be a single value, a range, or an evaluated expression.
Applied constraints result in plots rendered from a subset of test iterations,
and the viewer applies constraints immediately to all plots. This is useful
when you want to screen out or filter test results in your attempts to find
or understand the results of a test.

Using Default Constraints
The Test Results Viewer, when opened after a test run, has constraints
present but not applied. The viewer creates a constraint for each test vector
and defines the constraint’s range as a function of the full range of values in
the test vector. These default constraints let you see the immediate effect of
your test’s test vectors on the results of the test.

For example, the Throttle demo has three test vectors corresponding to
changes in damping, mass, and stiffness to a Simulink model. If you display a
line plot as explained in “Generating Plots” on page 9-8, you get a plot similar
to the following:
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This output shows that the test results group in small clusters. You can use a
constraint to see which of the test vectors cause this clustering.

1 Return the plot to the previous state by clicking the menu next to as and
clicking color, then click the Refresh Plot button.

2 In the Constraints pane, select the check box next to the Damping
constraint. The constraint becomes active showing all tests with a Damping
greater than or equal to 5.0, which is the lowest value in the range of test
vectors. All test results remain in the plot.
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3 Click the right-pointing arrow at the end of the Damping constraint’s
slider.
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This advances the constraints slider by one value of the test vector, which
causes the first value of the Damping test vector to be removed from the test
results used in generating the plot. The viewer immediately applies this
constraint to the plot, which, in this case, removes the left-most cluster of test
results from the plot.
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The constraint counter gives another way for you to see whether the constraint
affected the test results. In this case, if you set the constraint value to 7, the
bar shows that there are only 72 of 90 test iterations visible because of the
constraint you just created. Thus these 18 test iterations that are screened
out have a Damping test vector value greater than or equal to 7 (see “Creating
a Test Vector” on page 1-14 to understand test vector values).
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Creating a Constraint
The Test Results Viewer lets you create a custom constraint based on the
following:

• A mathematical expression

• Scalar logical test results

• Scalar numeric test results

• String test results that have a value for each test iteration

• Test vectors

You can see an example for creating a constraint based on a mathematical
expression in “Viewing Test Results in the Test Results Viewer” on page 1-40.

A constraint you might want to create regularly would isolate test results
that have passed or failed. This is useful if your test contains a Limit Check
element that assigns data to a test variable that you choose to save as a test
result. When this test variable is saved, SystemTest records the test iteration
and whether the test passed or failed (represented by a 1 or 0); you can create
a constraint based on these test results. For example:
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1 If you activated the Damping constraint in “Using Default Constraints” on
page 9-28, deactivate it now by clearing the check box next to Damping,
or delete it.

2 Click the New Constraint button.
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The Add a New Constraint dialog box appears.

3 Click the list beneath the Using a result or test vector field to show the
list of test vectors and test results available for basing a constraint on.

4 Scroll down and select pass_fail in this list. This is the name of the test
result that is used to save the Throttle demo’s Limit Check element’s
output.

5 Click OK. The viewer adds the new constraint to the Constraints pane,
but it is not active.

6 Select the check box next to the pass_fail constraint to apply it.
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7 Change the operator to ==. The value is already set to 0, representing
failed test iterations.

You now have a constraint set to show only those test iterations that failed.
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If you change the value of the constraint to 1 using the slider, you will show
only those test results that passed the Limit Check element in your test.
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Plotting Single Iterations
The constraint option Plot single iteration at a time lets you step through
and see individual test results within the subset defined by the active
constraints. The plot shows only one test iteration until you choose to show
the next or previous one. The specific values for that test iteration’s test
vectors and test results appear in the Current Iteration pane. This is useful
when you want to know what combination of test vectors allow a test to pass,
or what values can lead to failure.

For example, if you follow “Creating a Constraint” on page 9-32, by the end
you have created a constraint that shows you all test iterations that have
passed. To see each iteration individually:

1 Move the slider for the pass_fail constraint back to 0.

2 Select the Plot single iteration at a time check box in the Constraints
pane.
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The Constraints pane changes to show a slider and the currently
displayed test iteration.

3 Move the slider or click the advance button to see the next iteration. You
see only those test results that match any defined constraints, which, in
this case includes only those tests that have passed.
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The Plots pane updates to show only the plotted line for that iteration.
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Viewing Simulink Time Series Data

In this section...

“Overview” on page 9-37

“Creating a Time Series Plot” on page 9-37

Overview
The Test Results Viewer lets you plot test results over time. Simulink can
generate time series data when it runs a model, and SystemTest can use this
data to generate time series plots. Instead of knowing simply that a change in
a test vector resulted in a specific test result value, you can now know when
during the test that the test vector caused that test result value to be achieved.

This section shows how you plot test results containing time series data. The
examples in this section use the model from the Inverted Pendulum demo;
if you want to load this model and follow the examples in this section, see
“Before You Begin” on page 4-3.

Creating a Time Series Plot
Time series plots require that you have time series data. Your test results will
contain time series data because of any of the following:

• Time series data is generated from Simulink Outport Signals, Simulink
Logged Signals, and Simulink To Workspace signals.

• The time series data was explicitly created in a MATLAB element and
assigned to a test variable that was saved as a test result.

• The viewer created a derived result that represents time series data
constructed from Simulink structs (with time data) or log signals. These
new derived results have names derived from their original test result
name and value.

You can verify whether your test generated time series data by reviewing the
test results list in the Test Results Viewer’s Data pane. The viewer labels
time series test results as being of type Simulink.Timeseries (Simulink
saves time series data within the workspace in Model Data Logs objects).
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To create a time series plot:

1 Run the test in SystemTest.

2 Click the Time Series Plot button in the viewer.

3 In the Define Plot pane, click the Y Axis menu to show a list of test results
with time series data. The Y Axis field shows only test results with time
series values. The X Axis field is always set to Time in a time series plot.
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4 Click the test result you want to use. For the Inverted Pendulum example,
click st_loggedsignal.

5 Click the Refresh Plot button.

The Test Results Viewer generates a time series plot with your selected data.

At this point, you can use the data exploration and refinement tools explained
in “Viewing Your Test Results” on page 9-7 and “Refining Your Test Results”
on page 9-28 to make more sense of the test results in the plot.
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For example, you can use a constraint to step through each individual
iteration, by selecting the Plot single iteration at a time check box.

As this example shows, the time series test result for a single test iteration
is composed of many values over time. There are many points with uneven
spacing reflecting the actual values of the signal over the time period.
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Saving and Reloading Test Results

In this section...

“Saving Test Results” on page 9-41

“Loading Test Results” on page 9-42

Saving Test Results
You can save the plotting and analysis work done in the Test Results Viewer.
Data, constraints, and plots created in the Test Results Viewer can be saved
and then reloaded in order to continue working on or viewing the data, or to
share it with others.

The following information will be saved:

• The data set created by SystemTest during your test run.

• Derived variables you create in the viewer.

• The layout state of the data tables (the order of the columns).

• Any constraints that you set up, and their order.

• Any plots you create, and their layout within the viewer.

Note Since any modifications made in the viewer could potentially be saved,
you will see the “file modified” indicator as soon as you do any actions in the
viewer, that is, the asterisk denoting a file as modified will be shown in the
viewer title bar.

To save your test results and the state of the Test Results Viewer, use the File
> Save Test Results or File > Save Test Results As commands from the
Test Results Viewer desktop.

When you use these save commands, a MAT-file is created that contains all of
the information listed above.
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Loading Test Results
There are four ways you can load test results in the Test Results Viewer.

• Load a saved results file from the File > Load Test Results menu in the
Test Results Viewer desktop.

• Load a saved results file from the MATLAB command line by typing
stviewer('matfilename'), where 'matfilename' is the name of the MAT
file containing your results.

• Open the Test Results Viewer automatically after a test runs in SystemTest.
To do this, be sure that the Visualize and plot saved results by
launching the Test Results Viewer option is selected in the Test
Properties pane in the SystemTest desktop before you run the test. After
the test executes, the Viewer is opened and the test results you mapped
in Saved Results are displayed.

• Open the Test Results Viewer any time after a test runs in SystemTest
by using the Tools > Test Results Viewer menu command or the Test
Results Viewer toolbar button from the SystemTest desktop. The results
of the last test that was executed will be opened in the viewer.
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strun

Purpose Run series of SystemTest test files

Syntax strun(testfile)

Description strun(testfile) runs the SystemTest test file specified by the string
testfile. You can specify testfile as the name of a test file, or as the full
path to a test file. If a test file name is specified without a full path, the
test file must reside on the MATLAB path.

testfile may also be specified as a 1-by-N or N-by-1 cell array of test
files, each of which is run serially.

Running tests that you set up in SystemTest from the MATLAB
command line using strun is useful for running multiple test files as a
batch or calling a test file as part of an M-file.

strun will run in a synchronous manner, that is, the MATLAB
command line will be blocked until strun finishes executing. strun will
finish executing when either of the following conditions is met:

• All test files have finished executing.

• A Ctrl+C is issued.

When a test is run, it is executed using the settings specified in the test
file. The only exception is the option to launch the Test Results Viewer.
If this option is enabled, it will be ignored.

If only one test file is specified, and the test encounters an execution
error, strun will error. If multiple test files have been specified, a
warning will be issued for any test execution errors, and the remaining
test files will be run.

Note It is recommend that you run the test from the SystemTest
desktop to verify that elements are not in an error state, and the test
will run successfully, before running it via the MATLAB command line
using this function.
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Note MATLAB will remain busy while tests are executing via the
strun command. Control is returned to the MATLAB command line
once all tests execute.

Examples Run a test called mytest that is on the MATLAB path.

strun('mytest')

Run a test called mytest that is not on the MATLAB path, but is in
a local directory called c:\work.

strun('c:\work\mytest.test')

Run two tests, called mytest and mytest2, that are both on the
MATLAB path.

strun({'mytest' 'mytest2'})

Run three tests, two of which are on the MATLAB path, and one of
which is not.

strun({'mytest' 'c:\work\mytest2.test' 'mytest3'})
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stviewer

Purpose Open Test Results Viewer

Syntax stviewer(filename)

Description stviewer(filename) opens the Test Results Viewer using the test
results saved in the MAT-file specified by the string filename.
filename must specify a MAT-file created by a SystemTest test.

Note that this function opens the Test Results Viewer directly from
MATLAB. The most common use case is to open the Test Results Viewer
from SystemTest at any time to see the results of the last executed test,
or automatically after a test runs that contains test results.

For more information about the Test Results Viewer, see Chapter 9,
“Using the Test Results Viewer”.
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Purpose Open SystemTest desktop

Syntax systemtest
systemtest(testfile)

Description systemtest opens the SystemTest desktop with a new untitled test.

systemtest(testfile) opens testfile in the SystemTest desktop, where
testfile is a SystemTest test file (.test) available on the MATLAB path
or specified with a full path.

Examples Open a test called mytest that is on the MATLAB path.

systemtest('mytest')

Open a test called mytest that is not on the MATLAB path, but is in
a local directory called c:\work.

systemtest('c:\work\mytest.test')
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SystemTest Hot Keys

The following keyboard shortcuts are available in SystemTest.

Key Description

Alt+N Activates the New button to create a new test
vector or test variable.

F1 Opens Help.

F5 Runs a test.

Ctrl+C While a test is running, stops the test.

Ctrl+C When a test is not running, copies selection in
some parts of the user interface.

Ctrl+N Adds a new untitled test.

Ctrl+O Opens a test.

Ctrl+Q Closes SystemTest.

Ctrl+S Saves a test.

Ctrl+V Pastes the copied selection.

Ctrl+W Closes a test.

Ctrl+X Cuts a selection in some parts of the user
interface.

Ctrl+Y Performs redo of last undo action.

Ctrl+Z Performs undo of last action.

Ctrl+0 Gives focus to the Test Browser.

Ctrl+1 Gives focus to the Properties pane.



A SystemTest Hot Keys

Key Description

Ctrl+2 Gives focus to the Test Vectors pane.

Ctrl+3 Gives focus to the Test Variables pane.

Ctrl+4 Gives focus to the Resources pane.

Ctrl+5 Gives focus to the Run Status pane.

Ctrl+6 Gives focus to the Desktop Help pane.

Ctrl+7 Gives focus to the Elements pane.

Ctrl+8 Gives focus to the Getting Started pane.

Ctrl+Shift+0 Gives focus to the Plots pane.

Ctrl+Shift+U Undocks the currently selected pane.

Ctrl+Shift+D Docks the currently selected pane.
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